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Introduction

Introduction to PEAKS Studio 3.0

PEAKS nafkes the interpretation of NS/ M data nimch easier and nmch
faster:

EAKS is an innovative software system designed to derive amino acid

sequences and identify proteins from tandem mass spectrometry data. After

running MS/MS on a protein sample, PEAKS performs de novo sequencing

and database search identification of the protein(s) and peptides using raw
experimental data.

PEAKS Studio 3.0 provides peptide sequence and protein identification results via an
intuitive interface, allowing for rapid visual interpretation. PEAKS provides both auto
and manual de novo sequencing tools for detailed examination of MS/MS spectra,
providing the flexibility to manually modify auto de nove results when searching for
additional sequence possibilities.

How to use this user’s manual

This user’s manual is intended to help us get started using PEAKS Studio 3.0, acquaint
us with its functionality, show us how to customize PEAKS to our application, allow
us to work efficiently with the interface, provide a task based reference, and help us
with troubleshooting. As such, this manual is organized into chapters based on these
categories. Use the table of contents at the front of this manual to access the relevant
section. If searching for the definition of a particular term (or abbreviation), please
consult the glossary — found in this section. The glossary will tell us what a particular
term means, but it will not tell us how it applies to PEAKS usage.




Scope

PEAKS users are assumed to be familiar with computer usage, and the operating
system environment. As such, it is beyond the scope of this manual to instruct the user
on the use of windows, dialogue boxes, menus, file storage etc. Please refer to the
operating system’s manual, or computer help books for such information. Similarly,
PEAKS users are expected to be familiar with mass spectrometry, standard operating
practices and data.

Terminology and Abbreviations Glossary
m/z: mass to charge ratio.

Deconvolution: rearrangement of the spectrum to show each monoisotopic peak
as if it were singly charged. Thus, to reposition them on the scale, PEAKS
multiplies the m/z of ion’s that were doubly chatged by two. Note that the
deconvolved scale PEAKS shows is ‘at +1.’

a-ions: an N-terminal fragment holding at least one charge; similar to b-ions and c-
ions. This is a prefix fragment of the peptide. The a-ion’s mass will be the sum of
the masses of the N terminal group, plus the intervening neutral amino acid
residues, subtract the mass of Carbon Monoxide.

b-ions: an N-terminal fragment holding at least one charge; similar to a-ions and c-
ions. This is a prefix fragment of the peptide. The b-ion’s mass will be the sum of
the masses of the N terminal group, plus the intervening neutral amino acid
residues.

c-ions: an N-terminal fragment holding at least one charge; similar to a-ions and b-
ions. This is a prefix fragment of the peptide. The c-ion’s mass will be the sum of
the masses of the N terminal group, plus the intervening neutral amino acid
residues, plus the mass of ammonia.

x-ions: a C terminal fragment holding at least one charge; similar to y-ions and z-
ions. This is a suffix fragment of the peptide. The x-ion’s mass will be the sum of
the masses of the C terminal group, plus the intervening neutral amino acid
residues, plus the mass of Carbon Monoxide.

y-ions: a C terminal fragment holding at least one charge; similar to x-ions and z-
ions. This is a suffix fragment of the peptide The x-ion’s mass will be the sum of
the masses of the C terminal group, plus the intervening neutral amino acid
residues, plus the mass of H.,.

z-ions: a C terminal fragment holding at least one charge; similar to x-ions and y-
ions. This is a suffix fragment of the peptide. The z-ion’s mass will be the sum of
the masses of the N terminal group, plus the intervening neutral amino acid
residues, subtract the mass of ammonia.




Residue: as used in this manual, a residue refers to what remains of an amino acid
once it has become part of a peptide, or peptide fragment. In this manual, residues
are referred to by their original amino acid names.

Resolution: refers to the precision of an instrument. On a spectrum, this is
reflected by how close together can two PEAKS be and still be told apart.

Mass accuracy: this refers to the accuracy of the spectrometer and its resulting
data. On a spectrum, this is reflected by how close the PEAKS are to the actual
masses of the ions they represent.

ESI (Electrospray lonization): A method for ionizing a sample into the mass
spectrometet.

MALDI (Matrix-Assisted Laser Desorption/lonization): A method for ionizing a
sample into the mass spectrometer. This has a characteristic effect of only
producing singly charged ions.

PTM (Post Translational Modification): A protein, just translated and hence
newly formed, may differ from its final form as a result of interaction with the
cellular environment (or the experimental environment). As they interact
chemically with the environment, residues may gain or lose molecules. This change
is referred to as a post-translational modification. Since PTM changes the mass of
residues, it must be accounted for when sequencing peptides by mass
spectrometry.

Built-in PTM: PEAKS comes equipped with a library of possible post-translational
modifications. These can be incorporated into a de novo analysis at the click of a
button.

Customized PTM: If the post-translational modification we are looking for is not
in the PEAKS PTM set, we may create our own entry, or modify an existing one.
This will appear as a customized PTM in the set.

Enzyme: The residues PEAKS can find in different positions in the sequence. This
is based on information about the enzyme used to digest our protein sample.

PTM set: A listing of all possible (built-in and custom entered) post-translational
modifications that PEAKS can use as a part of its analysis.

Enzyme/PTM set: Combined, the enzyme information and post-translational
modification information provide PEAKS with the relevant parameters of the
experiment/sample. This will be applied to the corresponding data set when
PEAKS performs its de novo analysis. It is a required parameter.




Fixed modification: sclecting a post-translational modification as a fixed
modification tells PEAKS that this modification is applied to all occurrences of the
residue(s) that the PTM can act on.

Variable modification: sclecting a post-translational modifications as a variable
modification tells PEAKS that this modification may or may not be applied to any
given occurrence of the residue(s) that the PTM can act on.

FASTA (Fast-All: A standard sequence database file format used for protein
identification. PEAKS can identify proteins from any FASTA-format database of
proteins.

PKL: The file format associated with Micromass instruments
DTA: The file format associated with SEQUEST software
MGF: The file format associated with Mascot. softwate

BSI (Bioinformatics Solutions Inc.): The makers of PEAKS and other fine
bioinformatics software.

ANZ file: 2 PEAKS ‘zip-compressed” XMI.-based ANNotated spectrum file
format. ANZ files preserve all the information from the PEAKS session.

ANN data file: within the ANZ file, a folder contains ANN data files that store the
MS/MS information and peptide information of one spectrum.

ANN index file: within the ANZ file, is one compressed file used to organize the
data; the ANN index file links to a directory containing multiple ANN data files.




Getting started with PEAKS
Studio 3.0

Everything e need to fenow from the beginning and step by step.

his section of the manual will guide us through the process of installation and
configuration of PEAKS Studio 3.0. If we run into any problems we can
refer to the frequently asked questions section of this manual. If problems
persist, contact technical support.

What we will need

Package contents
The PEAKS Studio 3.0 package should contain:

=  'This manual
=  PEAKS Studio 3.0

= Release Notes

System requirements
PEAKS Studio 3.0 will run on most platforms with the following requirements:

= Equivalent or superior processing power to a Pentium at 500 MHz.
= Atleast 512 MB of memory (RAM). 1024MB is recommended.

® JAVA Virtual Machine 1.4 or better.

Instrumentation
PEAKS Studio 3.0 will work with data from any type of tandem mass spectrometer.




It was originally built for use with Q-TOF instruments, but has been tuned to work
with many other instrument types (Ion-Trap, TOF-TOF, FIMS, etc.). The more
resolution and mass accuracy an instrument gives, the better the results from PEAKS
Studio’s de novo analysis.

A note on ion-trap instruments

Ion trap data is usually of lower resolution than Q-TOF data, but
PEAKS Studio 3.0 can still use it to sequence peptides. One simply has
to configure PEAKS for use with ion trap. This setting can be set by
selecting “ION Trap” as the instrument in the auto de #ovo dialogue box —
discussed later.

mzXML is a PEAKS will accept data directly from Waters/Micromass instruments in .pkl and
standard data RAW formats, Thermo-Finnegan instruments in .dta format, the ABI 4700 (directly
format from the from the database) and data from any other instrument that can be converted into .dta,
Sashimi Project. It pkl, mzXML or .mgf.
is an XML based
format.
Installation
If we already have PEAKS installed on our system, we should uninstall it before
proceeding.

1. Close all programs that are currently running and end all non-system tasks.

2. Insert the PEAKS Studio 3.0 disc into the CD-ROM drive. This is the BSI
disk which lists its contents as

* PEAKS Software
=  PEAKS Movies
= PEAKS Tutorial
3. Auto-run should automatically load the installation software. If it does not,
find the CD-ROM drive and open it to access the disc. Click on the exe
file.

4. A menu screen will appear with the title “PEAKS Studio 3.0”. Select
“Install Peaks Studio”.

5. The installation utility will begin the install. Wait while it does so. When the
“PEAKS Studio 3.0” installation dialogue appears, click the “Next”
button.




11.

Read the license agreement. If we agree to it, we change the radio button
at the bottom to select “I accept the terms of the License Agreement” and

Next we choose the folder/directory in which we’d like to install PEAKS
Studio 3.0. Press the “Choose...” button to browse our system and make
a selection, or type a folder name in the textbox. Click “Next”.

Choose where we’d like to place icons for PEAKS Studio 3.0. The default
will put these icons in the programs section of our start menu. Click

Review the choices we have made. We can click “Previous” if we’d like to
make any changes or click “Next” if those choices are correct.

6.
click “Next”.
7.
8.
“Next”.
9.
10.

PEAKS Studio 3.0 will now install on our system. We may cancel at any
time by pressing the “Cancel” button in the lower left corner.

When installation is complete, click “Done”. The “PEAKS Studio 3.0”
menu screen should still be open. One may view movies and materials
from here. To access this menu again, we simply insert the disc in our CD-

ROM drive.

Registering PEAKS

The first time we run PEAKS, we will be told that the product is not registered. Press
the “Ok” button and a dialogue will appear. Enter the registration key that came with
the product — whether it be a key for the full version or time limited trial version. We
must also enter our name, the name of our organization, and the MAC address of the
machine we are going to use PEAKS on. If we are connected to the internet,
registration will be completed automatically. If all is well, a dialogue will show
“Registration Successful” and PEAKS will load.

Re-registering PEAKS may be necessary if our license has expired or if we wish to
update the license. We will need to obtain a new registration key from BSI. Once we

sl PEAKS Studic

have obtained this new key,
select “Register Peaks” from

the Help menu. The “License | File Edit Tools Windows | Help |

Upgrade” dialogue box will @ _.?EHE |E ¥ 0 | usermanual
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Database Configuration

In addition to de novo sequencing of peptides, PEAKS Studio 3.0 also has the ability to
search through a database search to identify proteins. But in order to use this function,
PEAKS must have access to a protein or EST database in FASTA format or an EST
database of DNA sequences. We can point PEAKS to an existing database on our
system, or download one. This is database configuration.

We can use PEAKS without the database search; PEAKS will perform de
nove sequencing only.

WARNING: Downloading a database can take a long time (8+ hours), depending
on connection speed.

To configure a database:
1. Load PEAKS Studio 3.0. If File | Edit| View Tools Windows Help P
we have not yet configured =l i Cony INREIEREER -
a database, the wizard will =P f’f || >
. H @ Paste
appear automatically. - Fs
9] therwise Configuration » 5 PEAKS Properties =
: 589.31 | BZ Emdronment Preference /
B34.4 1
¢ 1 Edit lon Tabl 3
2. In the ‘edit’ menu, select ey e — .
. ® 72882 [ & ymport Database Wizard 7
“Configuration”, then ® 77941 : —
« Datab Wizard” @® 79292 J _ f/'
mport atabase 1zar W 2 o T3 I e -

3. The Import Database Wizard will load and ask us to select a database to
download — from the dropdown list. If we already have a database we
wish to use, we can select “Other database” from the dropdown list
and skip to step6. Click “Next”
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The next section x

provides a FEAKS Studio version 2.0+ can do protein identification with any FASTA format sequence database
This wizard will help you download datahase and configure it.

walkthroth of Ifthe database you want to download is in the following list, please select it, and click Mext button.

PEAKS Studio 3.0’s Ifyou already have FASTA farmat database in local harddisk, arthe database is notin the list,

main functionality please choose "Other database” from the list and click Mext hutton

using the Swiss-Prot UniPrat (Human Mouse and Rat)y ¥

database. UniProt (Human Mouse and Rat)
IPl {Human, Mouse and Rat)
MEDE

MNCEI nr

Swiss-Prot

TrEMBL

Other datahaze

Previous | Next | inish | Cancel |

Microsoft Internet 4. Having selected a database, the Import Database Wizard will provide us
Explorer, for with some information about that database. If this is, in fact, the database
example, is an FTP we wish to use, click the provided link to begin downloading. A dialogue
client. You may box will appear with instructions on downloading using file transfer
use Internet protocol (FTIP). It does not matter where we put the download file, but we
explorer and the must remember where it is.

provided URL to

download a
database. A note on downloading

The links in the Wizard may be outdated because the owners of those
download locations may change their URL periodically. If this is the case,

remove all but the domain name and browse from there.
ftp://ftp.ebi.ac.uk/pub/databases/MassSpecDB/msdb. fasta.z

becomes:
ftp://ftp.ebi.ac.uk/

5. The database we downloaded may be in a compressed file, perhaps a .zip file.
We must find the file and use a decompression utility, such as WinZip, to
extract its contents. It makes sense to place the extracted file in a location that
PEAKS Studio 3.0 can easily access.

6. Return to the Import Database Wizard and click the “Next” button. This
screen will allow us to configure the database. Click on the hyperlink next to
each field for more information.
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Import database wizard ) x|

Database Nickname: | |

Path: | || Browse

[C] EST datahase

~Advanced Options - Fasta header format set up

Use built-in datahase format: | UniProt i | | Apphy |

Rule to parse accession/id string from FASTA title:
R |

Bule to parse description string from FASTA title:
54107 |

UBL to get detailed information with accession/fid:

|htlp:IIsrs.ebi.ac.uk.fsrsbin.fcgi—binMgeiz'?-eﬂUNlPROT:' | #Accession/ DR |]

Delimiter: |

Previous | Next | Finish || Cancel |

o PEAKS will ask us to enter the database nickname. This is a nickname that
we chose to represent the database we are configuring. We must enter at
least one character.

® The Path textbox shows where the database is located. It will be blank, so
we must tell PEAKS where the database is. Type the location of the file
into the textbox, or we can browse to find the file on our system We must
sure to select the FASTA database, not the compressed file of the same

name.

Database header ® If we chose one of the public standard databases (in step: 3) its format
format is important style will be displayed in the advanced options box. The selected database
for protein ID result format is shown in the dropdown list. Accession number information and
reports. If parsed the way PEAKS parses the database headers — i.e. the parsing rules —are
correctly, accession shown in the textboxes below.

numbers and protein

names will be shown ® If our database is an EST database containing DNA sequences, check the

in full. ‘EST database’ checkbox.

® If we chose an “other database” (in step: 3) we must enter parsing
parameters ourselves by typing in the textboxes. Alternatively, if our
database format is the same as one of the public databases, we can choose
to apply that database’s format when PEAKS reads our database. Select
the database that is similar to ours from the dropdown list and press the
apply button to fill the textboxes with the appropriate parsing rules.
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The delimiter is the character used to separate multiple headers.

7. Press the “Finish” button to complete the database configuration.

We can repeat this process to configure a number of another databases. Once
configured, a database need not be configured again unless we update the database
itself.
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See the section
entitled “Merging
Spectra” for more
help.

Features Walkthrough

L ets fansitianize oonrselves with PELAKS

his section of the manual will walk us through most of the basic functionality
of PEAKS Studio 3.0. After completing this section we will have seen how
easy it is to load and view a data file, perform de novo sequencing, and database
search protein identification.

Begin the walkthrough

Download and configure the Swiss-Prot database. The procedures for doing so are
outlined in the previous section.

Run PEAKS Studio 3.0 and open a datafile by clicking the @ icon on the toolbar in
the upper left corner of the PEAKS window, or selecting “Open” from the “File”

menu.

Sample data is located in the “C:\Program Files\PEAKS Studio\data\multiple
spectra” folder. Load the file “SampleData.pkl” by clicking on it, then clicking
“Open.”. In the PEAKS Studio Demo, the demo sample data will load automatically
on startup under the heading SampleData.pkl.

After clicking “Open”, PEAKS Studio 3.0 will ask if we want to merge spectra. In the
dialogue box that appears, choose 0.01 using the drop down list box. Spectra who’s
precursor masses are within this range of each-other will be merged together.

The data file will appear in the left-hand frame. Make sure “SampleData.pkl” (i.e. the
data file) is selected.

In the “Tools” menu, select “Protein Identification”
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Enter the settings
as shown. Settings
can be changed by
clicking on the
drop down list and
selecting one of
the options.

% PEAKS Studio

File Edit View | Tools | Help

@@@ ¥ Enable Tasks Running E_j@@

= Peptide Data | 2 Work Flow
- Earrligza.t }—v Merge Spectra

® 5248 2 auto De Novo
:233 =¥ PEAKS protein ID

@673 = -
@7 &_.: inChorus protein ID
@ 779. & Mass Calculator
® 79282

®a1732

® 110542
® 112502

P S Ny

The following dialogue should appear:

Protein Identification "

-

1

p
4

~Protein ldentification Options

Search in database |5WissF‘r01 > |
Parent mass errar talerance: |EI.1 | b |
Fraament mass error tolerance: |EI.1 | - |
Enzyime and PTH: |Trg.rpsin with Cam > |
Instrument: | Ciuadrupole-TOF o |
Report top: |1D | - |
Faor best results, try error talerance of 0.1 for data from Quadrupole-TOF

i) Use existing peptide sequences

@) ge existing peptide sequences and the results from fresh auto de novo

~Auto De Nowvo Options
Parent mass error tolerance: |D.1 | b |
Fragment mass errartalerance: |EI.1 | b |
Enzyime and FTh: |'Tr:.rpsih with Carm > |
Repor top: 5 |-
[¥l Preprocess befare data analysis
Edit Databases and Enzyme/PTM Sets | OK Cancel
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The numbers
under the “Mass”
heading represent
the mass of the
protein displayed.
The “Coverage”
numbers represent
the percentage of
the proteins
sequence covered
by the matching
peptides.

Click “OK”, after entering the settings shown, to commence PEAKS auto e novo.

The process will take about one minute, after which PEAKS database search will
proceed. In total, the process takes less than two minutes for this sample (depending
on the system’s processing speed and memory). The PEAKS auto e novo algorithm
derives sequence candidates for each of the eleven spectra in our example data file.
These sequence candidate results for all eleven spectra in the example are then used for
the database search component of PEAKS Studio 3.0. PEAKS uses a unique sequence
tag plus fragment ion mass matching approach to protein identification.

Click “Protein ID Result” under the file name in the Peptide Data frame (left). PEAKS
Studio 3.0 presents a list of proteins that it believes to be the best match for the
sample. This index lists them by accession number, ranked in descending order from
highest score on downward.

Result from database Swiss-Prot(0.1 0.1 Trypsin with Cam)
Accession Mass Score Coverage

CYC_BOV more 11547.01 09.36% 50%
GHALL_C more 23000.800 30.34% 2.53%

Description
=CYC_BOVIN (Pd2894) Cytochrome c
=ONALL_ CANFA (P52206) Guanine nucleotide-binding protein, alpha-11 subunit {Fragment)

Since CYC_BOVIN is at the top of the list it is most likely that the sample contains
Cytochrome c. Since one cannot distinguish between Bovine Cytochrome ¢ and
Equine Cytochrome ¢ (or that of some other organisms), it is not necessarily Bovine
Cytochrome ¢; CYC_BOVIN is displayed simply because it is the first entry in the
database. Clicking the more hyperlink next to CYC_BOVIN will show a listing of
other possible Cytochrome c.

The listing, as shown above, is simply an index. To see why PEAKS chose
Cytochrome ¢ as its best possible protein candidate, click the CYC BOVIN
hyperlink. The report will scroll to the following:

CY¥C_BOV more.. >CYC_BOVIMN (PA2894) Cytochrome ¢

Mass: 1154701 Score:?% 36% Coverage:50% [Show missed de novo results)
Mz Charge Mr(calc) Start Fnd Score Pepiide
4827 2 9455171 92 99 9% EDLIAYLE
5848 2 11406042 28 33 99% TGPRLHGLFGE
634.4 | A15.3744 0 13 06.04% [FVQK
783 1 59 36436 74 70 g% YIPGTE
7188 2 14376525 40 53 9% TGOAPGFIYTDAMK
7704 | 76043054 30 36 T1.13% MIFAGIK
7020 2 15657474 39 53 00.04% KTGOQAPGFSYTDANE

[Feturn to top)
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Above, 8 of the original 11 spectrum were found to have a matching sequence with
Cytochrome c. For example, the search found the peptide EDLIAYLK in the 482.7
spectrum. Fach peptide match shows a high confidence: strong evidence for having
found the correct protein. We can see a list of good spectra that did not match up to
this protein by clicking the [Show missed de 7ovo results] link.

We can also see exactly where the peptide fits into the protein sequence. To see where
the match was made click the CYC BOVIN hyperlink (the one right above the
peptide results). This brings up a “Protein View” window with the matching sequences
highlighted in red. Close this window now.

As  mentioned above, the peptide

File Edit View Tools Windaws Help
sequence results are based on a database A TE e ey e

search guided by an initial de #ovo analysis. |7 et

1= CyiC-ESlanz

*
v

Protein ID Result

Let’s see how the de novo was able to help. g
Click on the TGQAPGFSYTDANK sy
hyperlink. This will bring up the spectrum ;
728.8 2 results window. Look in the top
right frame to see the de novo and database
results.

[N

Feptide Candidates
1 PEAKS Auto Die Nova (0.1 0.1 Trypsin without PThis)
AAGSAPGFSTTDANK 25.4%
TGQAPGF SYTDANK 22.5%
ASQAPGFSYTDANK 20. 8%
SAQAPGF SYTDAMNK 15.7%
GTQAPGF SYTDAMK 15.7%
1 PEAKS DB Search (nchi 0.1 0.1 Trypsin with Camy
TRQAPGF SYTDANK 29%
El PEAKS DB Search (Swiss-Prat 0.1 0.1 Trypsin with Cam)
TGQAPGF SYTDANK 29%

Calor Code: »80% 80-90% 60-80% <60%

Color coding shows positional
& p & 72882

confidence scores. By the letters -
. 11| &) i |3 2[5]9| JumptoProtein i resf.
coded in red we can see that the T C'%idlﬁes'_“ LIole) [21B1%) Jumpofrucch res.‘

PEAKS auto de novo analysis B PEaks Auto De Nova (0.1 0.1 Trypsin without PThs)

returned, with >90% confidence, MaabshonDaE 2onde
. . TEOAPGFSYTDANE 22.5%
the partjal pepude sequence ASQAPGFSYTRANE 20. 8%
SAQAPGFEYTDANE 15.7%
APGFSYTDANK, but Wa§ not Comke s il e s
as sure of the first three residues. NE FEAKS DE Search (nchi 0.1 0.1 Trypsin with Garm)
TEOAPGFSYTDANKE 99%
The PEAKS DB Search was able §5 peacs ng ssarch {Swiss-Prot 0.1 0.1 Trypsin with Gam)
to confirm this result, returning: TGQAPGF SYTDANK 39%
TGQAPGFSYTDANK.

Clicking on the Peptide Data

Frame, and seclecting another [Color Code: ~80% 50-90% 50-80% <60%
spectrum, e.g. 589.3 1, will allow
us to view the results from that
spectrum  without having to \.

return to the protein | b " BT o
identification result. Alternatively,

click on “Protein ID Result” to return to the report.

\/‘\_ﬁ_\ ""‘:M“-\E’——‘-W

Thus concludes our walkthrough of PEAKS Studio 3.0’s basic features.
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Graphical User Interface

A reference section 1o belp us find our way aromnd.

his chapter deals with interface elements. It is meant to be used as a reference
so we can look up certain interface elements when we get stuck. For
instructions on how to use PEAKS Studio to perform certain tasks, the
section entitled “Using PEAKS Studio” will be more instructive.

The first part of this chapter describes windows, dialogues, frames and reports. This
tells us what certain dialogue boxes, windows and frames do and how to read them.

The second part of this chapter deals with toolbars. Toolbars are a very useful way to
quickly get at the functions we use most.
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Windows, Dialogues, Frames and Reports
PEAKS Studio 3.0 main window

|4 PEAKS Studio

Compirises:

Peptide data frame (left): This displays a listing of parent ions by
m/z and charge. Clicking on one will bring up the its MS/MS
spectrum. The colored dot by each spectrum shows dark green for
unprocessed, or light green for sequenced (or partially sequenced). An
asterisk (*) next to a spectrum shows that it contains unsaved
information.

Spectra are grouped by data files, or by nodes (which act like data
files). Select a data file or node by clicking on its name (i.e. click on
CytC-ESLanz in the above example), or a spectrum within a data file
by clicking on it. Use the ‘ + * and ‘-’ boxes to expand and collapse
the view.

Task Queue frame (bottom left): Shows running tasks, sorted by
priority.




This dialogue will
appear each time
we run auto de
novo. If we always
use the same
settings, set them
as default and de
novo will proceed
automatically.

Working area (right): This is where the Protein Identification Result
Window and the Main Processing windows appeat.

Menu bar: access file, edit, view, tools, windows, and help commands.

Main window toolbar: quick access to many commands. See

“Toolbars” section below

Auto de Novo Parameters Dialogue

x|
Parent mass error tolerance: 0.1 -
Fragment mass error tolerance: (0.1 -
Enzyime and PT: |Trg.rpsin with Cam o
Repaort top: L] -
Instrument: Cluadrupole-TOF =

For best results, try errar tolerance of 0.1 for data from Guadrupole-TOF

[_| Preprocess before De Maovo

[_1 Use this configuration as default

Edit PEAKS Properties

oK

Cancel

Parent mass error tolerance: determines how much random and
systematic expetimental error on the parent/precursor ion PEAKS

will account for in its analysis. Select a tolerance from the dropdown
list.

Fragment mass etror tolerance: determines how much random and
systematic experimental error on the fragment/daughter ion PEAKS

will account for in its analysis. Select a tolerance from the dropdown
list.

Enzyme and PTM: choose from a dropdown list of enzymes that we
used to digest our protein sample, and PTM that have acted on it.

Report top: set how many peptide sequences PEAKS will report.
Choose from a dropdown list.

Instrument: choose the type of spectrometer that produced our data.
Choose from a dropdown list.
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= Use this configuration as default: check this box to keep these
settings. The PEAKS Properties dialogue will no longer appear before
auto de nove. It can be accessed any time by pressing the “Edit
Environment Preference” B toolbar button, to load the Environment
Preference Dialoged and then clicking the “auto de novo” tab.

* Preprocess before auto de novo: PEAKS Studio has its own built-in
preprocessor for removing noise, centroiding, and peak charge
recognition from MS/MS data. Check this box to turn preprocessing
on.

=  C(Click the “Edit PEAKS Properties” button to see the PEAKS
Properties dialogue (discussed below).

Protein Identification Parameters Dialogue

x

~Protein ldentification Options
Search in datahase |5Ewi55Prnt "|
Farent mass error tolerance: |IZI.1 | - |
Fragment mass error tolerance:; |IZI.1 | - |
Enzyme and PThi: |Trg.rp5in weith Cam - |
Instrument: | Giladrupole-TOF ! |
Repart top: |1IZI | - |
For best results, try errar tolerance of 0.1 for data from Quadrupole-TOF

™ Use existing peptide sequences

i Use existing peptide sequences and the results from fresh auto de novo

—Auto De Novo Options
FParent mass error tolerance: | I =
Fragment mass error tolerance:; | 1
Enzyme and PTH: [Trypsin with Cam -]
Repart top: | [+ |

[1 Preprocess hefore data analysis

Edit Databases and Enzyme/PTM Sets | 0K Cancel

This dialogue shows the same options for auto de novo, plus some options specific
to protein identification:
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Parent mass error tolerance: determines how much error PEAKS
will allow on the parent/ptrecursor mass when searching through the
database. Select a tolerance from the dropdown list.

Fragment mass error tolerance: determines how much error
PEAKS will allow on the fragment/daughter mass when searching
through the database. Select a tolerance from the dropdown list.

Enzyme and PTM: choose from a dropdown list of enzymes that we
used to digest our protein sample, and PTM that have acted on it.

Instrument: choose the type of spectrometer that produced our data.
Choose from a dropdown list.

Report top: from the dropdown list, choose the maximum number of
protein candidates to report.

Use existing peptide sequences: Select one of these radio buttons
to either use sequence data that we’ve already created, or to perform
auto de novo sequencing before the database search portion of our
protein identification. The database search phase of protein
identification uses whatever sequence information we already have, to
filter through the database. If we have not already e novo sequenced
our data (or if we wish to re-sequence de novo) we should perform auto
de nove sequencing prior to the database search process.

Auto de novo options: these are the same set of options as can be
accessed from the auto de novo parameters dialogue.

Click the “Edit Databases and ENZYME/PTM Sets” button to see
the PEAKS Properties dialogue (discussed below).
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PEAKS Properties Dialogue
F4PEAKS Properties X

(| EnzymePTMs set

List of EnzymeiPTh sets
Meuropeptides
Trypsin (R without PTh
Trypsin Wy C-amidatian, M-pyroG
Trypsin Wy Commonhods 2 Edit
Trypsin W commaon moads + Cam
Trypsin w Amidation View
Trypsinw BN Mods H
Trypsin w Common Mods -

Hew

Remove

| Import || Export | oK Cancel

*  Enzyme/PTMs set tab: Displays a list of built-in and user-defined
Residues/PTMs sets. You may edit and create Enzyme/PTMs sets
from here.

= PTM tab: Displays a list of built-in and user-defined PTMs. You may
edit and create PTM from here.

* Database tab: Displays a list of databases available to PEAKS. You
may make new databases available to PEAKS from here.

Enzyme/PTM Editing Dialogue

4l Enzyme,PTM Set Editing I |

Modifications |
PTMs that can be selected Selected Fixed PThs
Lab 2 custom PTM Carbamidometindation
=Built-In= Acetylation
=Built-In= Amidation
=Built-In= Beta-methylthiolation
=Built-In= Biotin
=Built-In= C-Mannosylation
=Built-In= Carbamidomethylation =
<Built-In= Carbarmylation Edit PTM Selected Yaried PThis
=Built-ln= Citrullination New PTHM Beta-methyithiolation
=Built-In= Deamidation
=Built-In= Dimethylation Remove PTM
=Built-In= FAD
=Built-In= Farnesylation
=Huilt-ln= Formwlatinn

Select As Fixed=>

Select As Varied=>

<=lnselect

4]

| OK || Cancel |

This dialogue is used in the process of creating or editing an ENZYME/PTM set. The
three tabs in this dialogue allow you to establish different attributes of the set. (Shown
above: the Post Translational Modifications tab). The process of editing and creating
an ENZYME/PTM set is described in another section of this manual.
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This dialogue
allows us to create
or edit a PTM

PTM Editing Dialogue

kullPTM™ Editing i |
Mame: |Acetylation | Abhbreviation: |

Mass (Monaisotapicy: |42 0106 Meutral Loss Mass (Monoisotopic): |00

Furmula:| |

Residues that can be modified:

Man-location specific |k m-terminus ADCEQGILMPSETY | C-terminus

Rule: |all kingdom |

‘ OK H Cancel ‘

* Name: This will appear in the PTM list
= Abbreviation: This will appear in the auto de novo results, if it is found.

* Mass (monoisotopic): The mass that the residue gains or loses as a
result of the PTM. Enter this numerically here, or enter the chemical
formula below.

=  Neutral Loss Mass: The mass that the modified residue loses as a
result of fragmentation. E.g. 28 would signify a loss of 28 Daltons.

®*  Formula: The chemical formula of the PTM. This will automatically
enter the mass.

* Residues that can be modified: Enter residues that can be modified
anywhere, residues that can only be modified at the N-terminus and
residues that can only be modified at the C-terminus.

= Rule: user entered, a comment for our reference.

lon Table Settings Dialogue
There are two such dialogues, one each for the ‘Advanced’ Ion Table, and the ‘Basic’
Ion table. The two dialogues are identical but for the table they effect.

See the below section entitled Main Processing Window for a description of the Ion
Table itself.




The ‘Basic’ and
‘Advanced’ lon
tables differ only in
the number of ions
they can display.
The ‘Basic’ table
displays up to six
ions.

F4"Advanced Ton Table” Settings

Please choose ion typesicharge combination, and add selections to ion table columns list.

lon Types lon Table Columns
Immonium : : Immonium
a LY ge | l: Y1 la
a-H20 1]
a-MH3 o h-H20
4] C
b-H20 v
b-MH3 v-H20
C F4
c-H20 z
c-MH3 W (2+)
» -

‘ Apphy H Cancel ‘

Ion Types list: A listing of all the types of ions PEAKS Studio
considers in its analysis.

Ion Table Columns list: A list of the columns that will appear in the
ion table, each representing a type of ion. The columns will contain the
masses at which the particular type of ion was found, if at all.

Chatrge list box (unlabeled): Each type of ion can be added up to 4
times, depending on the charge we specify.

Add with charge button: After selecting an ion type from the Ion
Types list and a charge from the list box, clicking this button will add
that ion to the Ion Table Columns list.
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The Protein
Identification
Result Window is
used to examine
the results of a de
novo guided
database search.
It presents the
proteins that are,
most likely, found
in the sample.

Protein Identification Result Window

I CWICESLanz

Frotein Candidates
nchif0.1 0.1 Trypsin with Cam)
Swiss-Prot{0.1 0.1 Trypsin with Cam)

esult from database Swiss-Prot(0.1 0.1 Trypsin with Cam)
Accession Mass Score Coverage
CYC_BOV more 11547.01 099.36% 50%
GMALL_C rmore 23000.800 30.34% 2.53%

Description
=>CYC_BOVIN (P62804) Cytochrome ¢
=GHALL_CANFA (P52206) Guanine nucleotide-binding protein, alpha-11 subunit (Fragment)

CYC_BOV more.. >CYC_BOVIMN (P62824) Cytochrome c

Mass:11547.01 Score:?9.36% Cowverage:50% [Show rmissed de novo results]
Mz Charge Mr(calc) Start End Score Peptide

4827 2 9455171 92 99 99% EDLIAYLE

584.8 2 1149.6042 28 38 90% TGPNLHGLFGR

i34.4 1 6153744 0 13 06.04% IFVQK

678.3 1 65036426 74 79 0% YIPGTE

718.8 2 1437.6525 40 53 99% TGQAPGFSYTDANK

74 1 76043054 80 86 71.13% MIFAGIK

7929 2 15657474 39 53 90.04% KTGQAPGFSYTDANK

[Return to top]

GMAll C more.. =GHALL CANFA (P52206) Guanine nucleotide-binding protein, alpha-11 subunit (Fragment)
Mass: 23099.809 Score:30.34% Coverage:2.53% [chow missed de nova results]

Mz Charge Mricalc) Start End Score Peptide
5803 1 570.30133 73 77 83.50% VDVEK
[Feturn to top]

= Database Frame (top): If we chose to search through more than one
database (or with different sets of parameters) to identify the protein,
our search results will be slightly different in each database. Selecting a
database (and parameters) from the list will display the protein
candidates returned from that database (and parameters). Those search
results will be displayed in the Search Result Report frame below. In
the example above, the database “Swiss-Prot” is selected with 0.1 error
tolerance, and “Trypsin without PTMs” as the Enzyme/PTM:s set.

= Search Result Report Frame (bottom): Displays the results of the de
nove guided database search. It is divided into two parts. The index and
the peptide match report.

* Index (top section): PEAKS presents a list of proteins that it
believes to be the best match for the sample. This index lists them
by accession number, ranked in descending order by score. [ery
Sipilar proteins (i.e. ones that contain most of or all of the sequences identified
by PEAKS) are grouped together — only the first entry in this group is shown
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The main
processing
window is used to
perform manual de
novo sequencing,
and to examine
the results of auto
de novo
sequencing

here. Access the whole group by dicking the More... hperlink. In the
example above, CYC_BOV is the top ranked protein candidate.

= Peptide Match Reports (bottom section): PEAKS presents
each protein candidate with a peptide match list beneath it. Each
peptide that matched the protein sequence is shown, in order, by
spectrum. The confidence that the correct peptide sequence was
found is displayed next to each peptide sequence.

Main Processing Window

P 589.3 1

i |[i e [ I =
FiF2 sl [i[2]el [2]a]2]
Peptide Candidates #
= PEAKS Auto De Mova (0.1 Trypsinwithe] 1
VDVEE 99% 2
DVVEE <l% 3
VLTEE <1% it
VDPME <1% 5
LTVEK <l1% T ———— 010
= PEAKS DB Search (sprot 0.1 Trypsin
VDVEE 99%
Lo O e S = S S et S b e ,
T SR S o e e 0.10
Cnlannde =~EID% ED B0% =% 000 40000 20000 20000 400.00 S00.00
| [»

276,18 314.13
268 .14

7208 10003 1911 5 b3 37822 44315 40025 589.28
IR [ ﬂ [ 2w m L—ﬂgﬂ 29
] 100 200 300 400 500 593.2?
| | 5 | | = | ; E—
! | ! | ! | ! | ! | ! |
i | b | £ | 1" | 0 | i 1 |YM3><
- i i i d i i i i
-1 I ] ] ] 1 ] 1 1 1
R e N - |
0k s L 1 b i i i 32 e o Ry G i s A e b s e L e e R L i ]
100 200 300 400 500 59327

* Main Processing Window Toolbar: quick access to many
processing functions. See “Toolbars” section below.

= DPeptide Candidates Frame (top left): PEAKS shows peptide
sequence candidates, ranked by score for the selected spectrum.
Peptide sequences are grouped by the headings: “Auto de novo”,
“Manual de novo”, “user defined result type” and “database search
results” depending on how they were derived. For de novo results,
positional confidence is color coded on each residue. More specific
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The ions displayed
in both modes can
be edited. See the
section in
configuring PEAKS
Studio 3.0

To switch views,
choose ‘Alignment
by’ from the ‘View
menu’

positional confidence appears when the mouse is held over a sequence
— this shows the confidence in each of its parts.

Ion Table Frame (top right): the Ion Table shows the proposed
ions with their corresponding masses -- i.e. the mass of the bl ion is
shown in the top right corner. The default Ion Table will display b, a,
immonium, yH20O, yNH3 and y ions in basic mode; it will display b,
b-H20O, a, ¢, immonium, y, y-H20, z, 2’ and y(2+) ions in advanced
mode. To switch from basic mode to advanced mode, choose ‘Show
ion table’ from the View’ menu.

The Ion Table Frame also contains an error plot (i may be necessary
to seroll down to see the error plot). The etror plot shows the confidence
each ion is assigned. The most confident results lie on the
centetline. Clicking a cell or column in the Ion Table highlights the
corresponding points on the error plot and corresponding
PEAKS on the spectrum.

Spectrum View Frame (middle): Shows a graphical representation
of the spectrum. Peak masses are labeled, as are the peaks associated
with identified ions. You can zoom in on the spectrum by clicking and
dragging over an area.

Spectrum Alignment Frame (bottom): Shows a graphical
representation of the spectrum. This view always shows the whole
spectrum and is used as a tool to help us navigate the spectrum view
frame. A blue bar along the horizontal axis of the alighment view
indicates the range of the spectrum view in the Spectrum View Frame.

The Spectrum Alignment Frame can also the positions of major
ions that delimit the proposed sequence. By default, the Spectrum
Alignment Frame displays b-ion and y-ion peaks and the derived
peptide sequence between them. The Spectrum Alignment Frame
can also show the position of c-ion and z-ion peaks.
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The lon Editor is
used when
performing manual
de novo
sequencing.

lon Editor
Tonkditor x|

Please choose ion type: Selected peak information:
® C Term lons me 136.0692
- intensity; 4.0323
2 N Term lons current ion:
" :
. | Ade |

V:ﬁg [ Remove
v.

Caomments:

| Apphy || Cancel ‘

= Selected peak information: displays information about the currently
selected peak.

* Under “Please choose ion type”, the radio buttons set whether the
ions in the “ion choice list” are C terminal ions or N terminal ions.

* Ion choice list: (left): lists the ions we can apply to the selected peak

=  Selected ion list (right): lists the ions we have selected add or
remove them using the “Add” and “Remove” buttons.

= Apply button: applies the ions in the “selected ion list” to the selected
peak.

Export Image Dialogue

x|
Width: [F40 | Height [480 | Format |aif
Filename: |C:1Prngram Files\PEAKE Studio\Dataumultinle spectran927 .4 .gif | =

[[] Export selected area
® Peptide candidate free

R
L lg

ey

) Current spectrurm wirdow

‘ Ok H Cancel
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Width and Height: together these determine the size of the output
image (measured in pixels).

Format: select an image file format from the drop down list. Bitmap,
JPEG and Graphics Interchange Format are supported

Filename: type in the textbox, or browse to a file @, to enter the file
name of the image that will be created.

Export selected area: the default image output is the full spectrum as
shown in the spectrum alignment frame, checking this box will allow
us to print one of the other items. For example, if we have zoomed in
on a portion of the spectrum and wish to print that zoomed in view,
we click the export button and select the “Export selected area”
checkbox, then the “current spectrum window”” radio button.
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Print Image Dialogue

— Paper
Sige: I Letter j
Source; IAutomaticaIIy Select j
— Orientation Marginz (inches)
& Portrait Left: |1 Eiight: I'I
" Landscape Top: |1 Bottom: I'I

Cancel |

Printer.... |

The default print output is the full spectrum as shown in the spectrum alighment
frame. If we wish to print something else, we must use the export image functions and
then print the image from another application.

Toolbars
Main window toolbar

Orientation: paper orientation
is shown in the picture at the
top. Change this by clicking the
“Portrait” or  “Landscape”
radio buttons.

Paper: Set the paper size and
source by selecting from the
appropriate dropdown list.

“Printer” button: pressing this
will bring up another dialogue
where we can select from a list
of printers installed on our
machine.

“Ok” button: this wil
commence printing,

@ "Open data file" button: This allows us to open a raw data file built by our

mass spectrometer, or a PEAKS data file (in ANZ format) that also contains
peptide analysis data. The file should be in PKL, DTA, MGF or ANZ

format.

ﬂ "Close data file" button: Close the selected data file. Press this after

selecting a data file in the Peptide Data Frame.

""Save data file" button: Save any changes made to the file (a “” will appear
next to any file that has been changed). The file will be saved in the ANZ

format. Press this after selecting a data file in the Peptide Data Frame.

@ ""Save all files" button: Save all files. Any changes to files will be saved in

the ANZ format.
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“Copy” button: Copy selected spectrum data.
“Cut” button: Cut selected spectrum data.

“Paste” button: Paste spectrum data into the selected data file.

B = = =

""Automatic De novo' button: perform auto de novo for a selected data file,
spectrum or list of data files. Press this after selecting one or more data files
(or spectra) in the Peptide Data Frame. An auto de novo options dialogue will
allow us to set parameters before we begin.

l@ "Protein Identification' button: perform protein identification a selected
data file. Press this after selecting one or more data files (or spectra) in the
Peptide Data Frame. A protein identification options dialogue will allow us
to set parameters before we begin.

B2 "Environment Preference Configuration" button: configure the
environment, spectrum color-coding, auto de novo parameters and manual de
novo parameters.

=

“PEAKS Properties Configuration” button: define PTM/ENZYME sets,
PTM, and add FASTA protein or EST databases.

@ “Import Database Wizard” button: help user download and configure
database.

Main Processing Window Toolbar

D “y ion Alignment” button: toggle (show/hide) the location of PEAKS
corresponding to y-ions and the corresponding proposed peptides between
them.

IE| “b jon Alignment” button: button: toggle (show/hide) the location of
PEAKS corresponding to b-ions and the corresponding proposed peptides
between them.

@ “Deconvolve” button: toggle (on/off) deconvolution of the mass spectrum
scale.

1) “1:1 zoom” button: return spectrum to original 1:1 zoom.
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@ “Undo Zoom” button: return to previous zoom ratio.

ﬂ “Edit Ion” button: set or edit the type of ion associated with a peak in manual
de novo. Press this button after having selected a peak in the spectrum view
frame.

@ “Next Peptide” button: redo changes to the peptide in manual de 7ovo.
@ “Previous Peptide” button: undo changes to the peptide in manual de novo.

@ “Export Results” button: export the spectrum view, ion table, or to a picture
(bmp, gif, or jpg format) with ions, masses, PEAKS and peptides marked.

@ “Print Results” button: print the spectrum view with ions, masses, PEAKS
and peptides marked.

ﬂ “View Results” button: show, in HTML format: the spectrum view with
ions, masses, PEAKS and peptides marked; peptides and confidence scores;
the ion table; and the error plot.
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PEAKS Studio Configuration

How 10 setup PEAKS Studliojust the nay e like it

his chapter deals with configuration. PEAKS Studio 3.0 is a versatile and

flexible tool. But in order to use the software to its full extent, we must learn

how to configure it to make it do what we want it to. Additionally, PEAKS

Studio 3.0 allows us to set up many defaults and presets to help us be quick
and precise.

We can use PEAKS Studio 3.0 without the need to configure; default settings will be
used. However, to increase efficiency we should set environmental preferences, and
PEAKS properties. This will enable us to customize the tool to our requirements. It is
recommended that we configure PEAKS Studio 3.0 before processing data files.

PEAKS Properties Configuration

One of PEAKS Studio 3.0 preferences, PEAKS Properties configuration sets the
parameters that the algorithm will use in processing our data files. PEAKS properties
include: PTM, Enzyme/PTMs set and database. PEAKS Studio 3.0 provides tools to
edit PEAKS properties for convenient use in de novo sequencing and protein
identification. To edit PEAKS Properties:

= Click the 8 icon in the main window toolbat;
= Or, from the “Edit” menu, select “Configuration” then “PEAKS Properties”

®  Or, Click the “Edit PEAKS Properties” button in the Protein Identification (or
Auto De novo Options) dialogue that appears before each Protein Identification
(or auto de novo) operation.

The PEAKS Properties dialogue will then appear. This dialogue box has three tabs:
“Enzyme/PTMs Set”, “PTM” and “Database”. Clicking a tab will allow us to edit




the PEAKS Properties corresponding to that tab. We can also import or export our
preferences to/from a file.

Enzyme/PTMs Set editor

Enzyme and PTMs are enzyme information and post-translational modification
information, respectively. The Enzyme/PTMs set is the combination of ENZYME
and PTM that we used in our expetiment/sample. If we select an Enzyme/PTM set
when we run auto de novo or protein 1D, Peaks will look for those PTMs in sequence
and return only peptides corresponding to the digest. For example, if we select “Trypsin
with Cam’ as our set, Peaks will look for Carbamidomethylation on Cysteine.

To see a list of Enzyme/PTMs sets, select the corresponding tab in PEAKS Properties
editor. From here we can create 2 new Enzyme/PTMs set, remove non-built-in
Enzyme/PTMs sets, edit non-built-in Enzyme/PTMs sets and view the configuration
of selected Enzyme/PTMs set. The sections below describe how to perform these
operations.

PEAKS Properties editor will show all existing Enzyme/PTMs sets in the list. There
ate two types of Enzyme/PTMs sets: <built-in> sets and user defined sets. PEAKS
software contains three built-in Enzyme/PTMs sets: “Trypsin with Cam’, “Trypsin
without PTMs” and ‘Unknown Enzyme without PTMs’. These built in sets cannot be
removed or edited by user. They cannot be overwritten, even if we try to create a new
Enzyme/PTMs set with the name of built-in set. User defined sets can be removed,
edited or overwritten at any time.

Creating a new Enzyme/PTMs set

To create a new Enzyme/PTMs set, we open the PEAKS Properties dialogue, ensure
that the ‘Enzyme/PTM’ set tab is selected and click the “New” button. The
Enzyme/PTM Editing dialogue will appear. Click the “Cancel” button at any time to
exit, discarding changes.

SilllEnzyme /PTM Set Editing i x|

['Name | Residues | Modifications |

Please Input a Mame:
Test

| OK || Cancel |

From the Name tab, we must enter a name for our new Enzyme/PTMs set. This is for
our reference only, but it makes sense to enter a name that will remind us of the
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The checkboxes
here represent the
possible digestion
products.

enzyme information and PTM that we are to enter (in the above example we’ve simply
entered “Test)). When clicking the Finish button after entering only a name, onr Engyme/ PIMs set
will be created using ‘Trypsin’ as the engyme information and ‘no PIM’ as the PTM information.

Clicking on the Residues tab brings up the following screen:

sl Enzyme /PTM Set Editing ' x|

((Name | Residues | Modifications |

Select Enzyme: | Trypsin bt

Residues at M-terminus:
WiaWiRViNWiDWICWMIEMOWGWHLCMLEKKRM¥ELCP WS VT w iy kv O SelectAll
Residues in the Middle:
iaviRvVinWiDic MEMGOMGMHLMLMKKMMMFEMP WS WT W iy vy O SelectAl
Residues at C-terminus:

JaMRONOD JcOEDde D6 [OH DI DOLMKkOM[OF [OR O [OT [Ow Oy I Salect Al

| 0K || Cancel |

Here we can enter enzyme information into our set. We can choose pre-defined
enzyme from the drop-down list. Based on the digestion properties of the enzyme, the
residues that are likely to be found at the N-terminus, C-terminus and in the middle of
the digestion product are marked with checkboxes (the check appearing to the left of
each letter symbol.) If the residue positions are not quite right for our enzyme we can
customize residues for different positions by selecting appropriate checkboxes (the
original definition of the enzyme will not be overwritten). Alternatively, we can choose
‘Unknown Enzyme’ from the dropdown list to define a new enzyme from scratch. If
we click the “Finish” button without specifying PIM, PEAKS will assume that we do not wish to
specify any PTM:

To specify PTM to search for, click the Modification tab. This brings up the following

screen:
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Selecting a PTM
as fixed tells
PEAKS that the
PTM will occurs in
all instances.
Selecting a PTM
as Varied tells
PEAKS that it may
or may not occur.

sl Enzyme /PTM Set Editing x|

[(Name | Residues | Modifications

PThis that can be selected Selected Fixed FThs
Lab 2 custom PTM Carbamidometindation
=Blilt-In= Acetylation
<Built-In= Amidation Select As Fixed=>
=Built-In= Beta-methylthiolation Select As Varied=>
=Built-In= Biatin
=Built-In= C-Mannogylation <=Unselect
=Built-In= Carbamidomethylation :
=Built-In= Carbamylation ! Edit PTM e SEETEN \I_anet_i i
<Builtin= Citrullination T T Peta:methyitiolation
=Built-In= Deamidation
=Built-In= Dimethylation Remove PTM
=Euilt-In= FAD
=Built-In= Farnesylation L.
=R uilt-In= Formulatinn X
| 0K | | Cancel |

Here we can from a list of available post-translational modifications. We can choose
any PTM as Fixed PTM or Varied PTM (to tell PEAKS that it may or may not occur).
To make this selection, click on 2 PTM in the list at left, and then click the “Select As
Fixed=>"" or the “Select as Varied=>" button. If a PTM is already selected as a fixed
PTM, it cannot be selected as varied PTM, and vise versa.

If we change our mind about a PTM after having selected it, it is still possible to
unselect it. Click the erroneous PTM from the list of ‘Selected Fixed PTM’ or ‘Selected
Varied PTM’, and then click the “<=Unselect” button to remove it from either list of
Selected PTM.

PEAKS software ships with some pre-defined PTMs. These are listed as
<Built-In>. If we want to create a new PTM, we can click ‘New PTM’ to
create 2 new one. The Editing a PTM and Creating a New PTM sections
below describes how this is done.

After having built our Enzyme/PTMs set, we can click the “Finish” button to save the
new Enzyme/PTMs set, or the “Cancel” button to exit, discarding changes. If we dlick
the “Finish” button without specifying residues, PEAKS will assume that this is a tryptic digest, and
apply the appropriate residues. After clicking the “Finish” button we return to the PEAKS
Propetrties dialogue to find that our new Enzyme/PTMs set is listed in the ‘List of
Enzyme/PTM sets’.
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P PEAKS Properties

| Enzyme/PTMs set |(PTMLibrary | Database |
List of EnzymeiPTh sets

Meuropeptides Mew
Test
Trypsin (B without PTh Remove
Trypsin Wy C-amidation, M-pyroG Edit
Trypsin W Commoniods 2
Trypsin W common mods + Cam Yiew
Trypsin we Armidation |
Trypsinw BN Mods -

| Import | | Export | 0K ‘ | Cancel

Editing an Enzyme/PTMs set

To edit an existing Enzyme/PTMs set, we open the PEAKS Propetties dialogue and
ensure that the ‘Enzyme/PTM’ set tab is selected. Choose a user defined
Enzyme/PTMs set from the list and click the “Edit” button. We cannot edit the built-in
Engyme/ PIMs sets. The Enzyme/PTM Editing dialogue will appear. We now follow
the same procedure as we would if we were creating a new Enzyme/PTMs set (see
above section).

Viewing an Enzyme/PTMs set
To view the configuration of an existing x|
Enzyme/PTMs set, we open the PEAKS
Properties dialogue and ensure that the
‘Enzyme/PTM’ set tab is selected. Choose
an Enzyme/PTMs set from the list and click

FesiduefPTH set; Test

Fesidue at M-Terminus:
ARMDCEQGHLKME STV

Residue at C-Terminus:

the “View” button. This presents us with a RK

summary of the selected Enzyme/PTMs  mesidue at other Positions:
set, including enzyme and PTM ARMDCEQGHLKMEPSTW Y
information. Click the “Ok” button when = Fixed PThis:

finished. We cannot edit the selected Carbamidomethylation
Enzyme/PTMs set from this screen. Varied PTMs:

Beta-methylthiolation

Removing an Enzyme/PTMs set

To remove a user defined Enzyme/PTMs set, we open the PEAKS Properties
dialogue and ensure that the ‘Enzyme/PTM’ set tab is selected. Choose a user defined
Enzyme/PTMs set from the list and click the “Remove” button. Built in Enzgyne/ PTMs
sets cannot be removed.

PTM Editor

If we know that our sample protein may have been modified since translation, we need
to apply this information to our analysis. This is done by creating an Enzyme/PTMs
set which incorporates enzyme information and PTM information (see above section).
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PTM Post
Translational
Modifications
affect the mass of
modified proteins
and residues

To edit the list of PTM available to PEAKS Studio through these sets we use the PTM
Editor. To select PTM editor, click the tab ‘PTM Library’ in PEAKS Properties editor.

[P PEAKS Properties i

[ EnzymePTMs set | PTMLibrary | Database |
List of PThis

x|

=Built-In= 4-hydroxynonenal (HME)

=Built-In= Acetylation

=Built-In= Acrylamide adduct

=Built-In= Amidation

=Built-In= Applied Biosystems cleavabla ICAT(TM) heawy
=Built-In= Applied Biosystems cleavable ICATTM) light

=Built-In= Applied Biosystems ariginal ICATTH) d0

=Built-In= Applied Biosystems iTRAQ(TM) multiplexed guantitation chemistry

Edit

Bl

Hew

-

| Import || Export |

0K

Cancel

All PTM are listed here. There are two types of PTM available to PEAKS: <built-in>
PTM and user defined PTM. From here, we can create a new PTM, edit an existing
PTM or remove a PTM from the list. See the sections below for help with these

operations. Built-in PTM cannot be removed from the list, but can be edited.

Editing a Built in PTM

It is possible to modify a built in PTM. PEAKS will save the
modification and treat this PTM as a customized PTM.
temporarily overwrite the built-in PTM - we will not be able to see the
original, built-in, PTM until we remove the customized one. We can
remove this customized PTM at any time and the built-in PTM will

reappear.

Creating a New PTM

It will

To create a new PTM, we open the PEAKS Properties dialogue, ensure that the PTM’
tab is selected and click the ‘new’ button. To create a new PTM ‘on the fly’ while making an
Engyme/ PIMs set, cick the “new PTM” button while selecting PTMs. The PTM Editing

dialogue will appear:
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5l PTM Editing : |

Mame: [TestPTM | Abbreviation: [TestPTM |
Mass (Monoisotopic): [-0.984 Meutral Loss Mass iMonoisotapicy: (0.0

Formula:| |

Residues that can be madified:

mlaon-lacation specific M-terminus C-terminus |ARMNDCEQGHILEM

Rule: |

| OK || Cancel |

Figure 1 Create new PTM

Now we type information pertaining to our PTM in the appropriate boxes (see above
section on Interface for a more in depth explanation of these fields). At a minimum,
we must enter a name, a mass and one residue that may be modified.

Enter the mass of the modification either by typing in its monoisotopic mass

difference directly, or by entering its empirical formula. It is unnecessary to do both;
each will override the other.

Click the “Ok” button to save changes and create our new PTM, or click the “Cancel”
button to exit, discarding changes.

After clicking the “Ok” button we return to the PEAKS Properties dialogue to find
that our new PTM is listed at the top of the PTMs list.

¥4 PEAKS Properties x|

PTM Librany

List of PThis
test PTH
=Built-In= 4-hydroxynanenal (HME)
=Built-In= Acetylation
=Built-In= Acrylamide adduct
=Built-In= Amidatian
=Built-In= Applied Biosystems cleavabla ICAT(TM) heawy
=Built-In= Applied Biosystems cleavahle ICAT{TM) light
=Built-In= Applied Biosystems iTRAQTM) multiplexed guantitation chemistry -

Edit

D

Hew

Remove

| Import || Export oK Cancel

Editing a PTM

To edit a PTM, we open the PEAKS Properties dialogue, ensure that the PTM’ tab is
selected, and select a PTM from the list by clicking on it and click the ‘Edit’ button. To
edit a PTM ‘on the fly’ while making an Enzyme/ PTMs set, dick the “edit PIN” button while
selecting PTMs. 'The PTM Editing dialogue will appear. Now we follow the same
procedure (see above) as we would if creating a new PTM.
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Removing a PTM
To remove a PTM, we open the PEAKS Properties dialogue, ensure that the PTM’
tab is selected, select a PTM from the list by clicking on it, and click the ‘Remove’

button. To remove a PINM ‘on the fly’ while matking an Enzyme] PTMs set, click the “edit PTM”
button while selecting PTMs. Built in PTM cannot be removed.

Database Manager

PEAKS Studio 3.0 needs a protein or EST database (in FASTA format) to identify
protein candidates. Since databases are being constantly updated, PEAKS does not
ship with a protein or EST database. Thus, we need to download it from the Internet
and tell PEAKS where the database is located. PEAKS provides the Database manager
as a tool to help us do this. To see a list of databases available to PEAKS Studio 3.0,
load the PEAKS Properties dialogue and click the ‘Database’ tab. From here we can
edit a database’s properties, load a new database, or remove a database.

P4 PEAKS Properties ). x|

| Enzyme/PTMs set | PTMLibrary | Database |

List of databhases

[Pl Hurman {Doirogersibty Documents\PEAKSDatadblipi HUMAR fasta) Mew
RICEl nr (Dolirogersihy Documents\PEAKS\D atawdbinr.fas)
* SwissProt (Doirogersihy Documents\PEARSID ataldbsprot.fas) Remove
Edit
Set as default

| Import || Export | ‘ 0K H Cancel |

Load/Configure a new database
For an in depth look at confignring a database, see the Database Confignration section in Chapter 2.

To configure a new database, we open the PEAKS Properties dialogue, ensure that the
‘Database’ tab is selected and press the “New” button. Now we open up our web
browser to find a database to download. Find one, download it, and unpack it. Return
to PEAKS Studio 3.0 and find the file on our system where we unpacked it. Name the
database and select the header format to use (or we can define our own). Click “Ok”.
The new database will now appear, listed by our chosen name, in the list of databases.

Remove a Database

To remove a database, we open the PEAKS Properties dialogue, ensure that the
‘Database’ tab is selected, select a database from the list of databases, and press the
“Remove” button. This will not permanently remove it from our system, it may be
reloaded (follow procedure for configuring a new database) at any time.
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We can’t edit the
database itself
from within PEAKS
Studio 3.0.

Edit a Database

This tool allows us to change the name that PEAKS Studio 3.0 associates with a
database, and the header parsing rules for that database. To edit a database, we open
the PEAKS Properties dialogue, ensure that the ‘Database’ tab is selected, select a
database from the list of databases, and press the “Edit” button.

Set the Default Database

Setting the default database changes the database that the protein identification search
will use by default. You will still be able to select another database before doing the
search if we so choose. To edit a database, we open the PEAKS Properties dialogue,
ensutre that the ‘Database’ tab is selected, select a database from the list of databases,
and press the “Set as default” button. The default database is marked with a * before
its name in the list of databases.

Moving/Updating a Database

If we choose to move a database to another directory, or delete it entirely, we should
tell PEAKS. We must remove the database from the list and re-load it. Until we do so,
the database name will appear in red in the list of databases, and any protein
identification using that database will fail.

P4 PEAKS Properties x|
(B et | PTMLibrary | Database |
List of databaszes

IPI Hurman (Dhirogersivly DocumentsiPEAKSIDatatdbtipi. HUMAN fasta) New

RICEl nr (Diragersibty Documents\PEAKS D ataldbinr fas)
* BwissProt (Doirogersibdy Documents\IPEAKSID ataldinsprot fas) Remaove

Eclit
Set as default
| import || Export | oK Cancel

If we choose to update the database [perhaps by downloading the latest database file
and overwriting the old database file], PEAKS will show the database information in
light gray. .4 light grey colour could also mean that the database does not have header information.
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4 PERKS Propertie x|
Database |

List of databhases

[Pl Hurman {Doirogersibty Documents\PEAKSDatadblipi HUMAR fasta) Mew

RICEl nr (Dolirogersihty Documents\PEAKS\D atawdbinr.fas)
* Bwiss-Prot (CProgram Files\PEAKS Studiolditsprot.fas) Remove

Edit
Set as default
| Import | | Export | ‘ 0K ‘ | Cancel |

Importing and Exporting PEAKS Properties

We may wish to use PEAKS Studio 3.0 on another system. However, if we have a
large number of user defined PTM and Enzyme/PTM:s sets it could take a great deal
of our time to re-input those. This is where importing and exporting of PEAKS
properties is useful.

The export function will save PEAKS Properties information in a XML file. The
import function can read a PEAKS properties XML file and overwrite local PEAKS
Properties with the information from XML file. If we wish to use our PEAKS
properties on a colleague’s system, we must remember to export our colleague’s
properties to a separate file so that it will not be lost and can be imported later.

A note on sharing sequences with PTM

Sequence data and protein identification results for a given spectrum are
stored in an .ANZ file. Any modifications that were found in the
sequence are also included. As such, user-defined modifications will still
show up if the file is viewed on another machine. It is not necessaty to
import all PEAKS properties to view these modifications. Also, user-
defined modifications can be extracted from an .ANZ file and added to
the local PEAKS properties.

To export PEAKS properties to a file, open the PEAKS Properties dialogue and
press the “Export” button. Type in a file name and press the “Save” button.

To import PEAKS properties from an file, open the PEAKS Properties dialogue and
press the “Import” button. Select a file or type in a file name and press the “Open”
button. This must be a PEAKS configuration file in XML format.
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To save user defined PTM to an .ANZ file for sharing, we simply save our work to
an .ANZ file as normal. Any user defined PTM will be preserved in the .ANZ file.

To import a user defined PTM from another user’s .ANZ file, we open the ANZ file
and find a sequence containing the user defined modification. Right click on that
sequence to bring up the popup menu. Click the “View Modifications” menu item.
This brings up a dialogue box named “Modifications”. Select the PTM of interest
from the dropdown list (in this example: Lab 2 custom PTM’) and click the import
modification button.

BTl 5803 1

FI2 sl [i]2]el [2]2]]
LIVLEL 2\
= PEAKS Auto De Movao (0.2 Unknown enzyme with L2custo

[LZcustomd)
{LZoustonk) Copy sequence to clippoard Ctl-C

(Lzcustonl) | Copyfor manual de novo
(LZcustonk)
[LacustonH)
= PEAKS DB Search Original iew
VDVWSAV 53.8 =
GAKGEAG 41%

View Sequence parameter

Pl L

Delete

aammian gn e e g

Lah 2 custom PTM w

dlliModifications

&
-
L
Show Modification e




Configuring the ion table

The ion table, displayed in the top right of the main processing window, displays all the
ions that were found as evidence for the selected sequence. There are two presets: the
Basic Table and the Advanced Table. Select which one to display by choosing “Show
Ion Table »”” from the “View”” menu.

=Y
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The Basic Table will display a maximum of 6 ions. The Advanced Table can be
configured to display as many as are available. To configure the ion table, choose “Edit

menu” > “configuration” = “edit ion table” and then select which table you'd like to
edit.

The Ion Table Settings dialogue box will appear:
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The ions types that will be displayed in the ion table are shown on the right. The
complete list of ion types available is shown on the left. To add an ion type to the ion
table (i.e. add a column to the ion table):

1. Select one or more ions from the list on the left. Use Shift+click and
Ctrl+click to select multiple list items.

2. Select a charge (from 1-4) from the drop down list in the middle.

3. Click the ‘Add with charge’ button

For example, configure the ion table to display y** ions by selecting ‘y’ from the list on
the left, and 2’ from the dropdown charge list.

Remove ion types from the ion table (i.e. remove columns from the table) by selecting
one or more items in the list on the right, and clicking the ‘Remove’ button.

PEAKS Environment Preference Configuration

One of PEAKS Studio 3.0 preferences, PEAKS Environmental Preference allows us
to customize PEAKS Studio 3.0 to our needs. PEAKS Environmental Preferences
include: Environment, Color, Auto de nove, and Manual de novo. To edit PEAKS Studio
3.0 Environment Preferences:

= (Click the E icon in the toolbar;

= Or from the “Edit” menu, select “Configuration” then “Environment
Preference”

The Environment Preferences dialogue will then appear. This dialogue box has four
tabs: ‘Environment’, ‘Color’, ‘Auto de novo’, ‘Manual de novo’ and ‘Merge Spectra’.
Clicking a tab will allow us to edit the Environmental Preferences corresponding to
that tab.
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Environment Preferences ﬂ

fEmJirnnment r:'fhﬁJr "F:M’taﬁéﬂw&-‘-"r Manual De Hovo :|/='Mﬁgg.5ﬂaetr_" tra |

~Default Data Input Directory:
CAProgram Files\Peaks_Studio_V25lData
® Previous directory Userdirectury.

~Default Data Output Directory:
CAProgram Files\Peaks_Studio_W25\Data
® Previous directory ) User directory |

~Default Configuration File Directony:
CADocuments and Settingsiirogersi peaks

[v] Cloze the main processing window before loading a new one far a diffierent spectrum.
[C] Load sample files at start up.
[_] Showe GRU Public License.

‘ OK H Cancel |

Environment
To change the working environment, we open the Environment Preferences dialogue
and ensure that the “Environment” tab is selected.

We can change the environment settings so that, when we are browsing our system to
find or save data files, PEAKS always starts looking in the folder we specify. The
current working folders for data input and data output are shown. We can choose to
have PEAKS Studio 3.0 use the last folder we loaded from (saved to) as the current
working folder, or toggle the appropriate radio button to “User directory” to set it
ourselves so that it will be the same each time.

The directory where PEAKS stores its preferences information cannot be changed in
this version of PEAKS.

Additionally, we can choose whether or not we’d like PEAKS to close a spectrum view
window once we have finished with it and move on to another spectrum. Click the
checkbox at the bottom of the window.

Once we’ve chosen from these options, pressing the “Ok” button will exit, saving
changes. The “Cancel” button will exit discarding changes.
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Colors

For ease of viewing, we can choose which colors we would like to represent which
items on the spectrum view. To change the color of an object on the spectrum, we
open the Environment Preferences dialogue and ensure that the ‘Color’ tab is selected.

|
r Emvironment r Color rnuhiﬁe}lwﬂ»r Manual De Novo Tr'?ﬂér_gg’iﬁ_‘ﬁﬁefra |
Flease choose calor for:

Spectrum_Peak
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< 1
Blug | o

n % I FEE! —K i current color Il

[y 230

Choose the object whose color we’d like to change from the list at the left. Then we
click on the slider bar, type in a number (0 to 255) in the textbox, or scroll up and
down on the arrows next to the textbox to select how much of the corresponding
color we’d like to apply. Choose an amount for all three colors. In the example above,
we’ve chosen pure red (255) to represent a spectrum peak. After we’ve chosen colors
we may click the “OKk” button to exit and save changes.

Auto de novo

Before performing an auto de novo analysis of our spectrum data, we must specify
certain parameters to the PEAKS algorithm. These include error tolerance,
Enzyme/PTMs set to use, database to search and instrument used. We can we do this
before each auto de novo run, but if we always use the same instrument and the same
experimental conditions, we may wish to avoid having to confirm these options every
time we perform auto de novo sequencing. To do so, check the box next to “use this
configuration as default”. These settings will be used for each auto e novo sequencing
operation, without confirmation.

To set parameters for auto de novo, we open the Environment Preferences dialogue and
ensure that the ‘Auto de novo’ tab is selected. We then select a value for each of the

48



To see how to
change the list of
Residue and PTMs,
refer to the above
section: PEAKS
Properties
Configuration

parameters to use by clicking on the dropdown list and selecting one of the options.
Clicking the Residue and PTM dropdown list brings up the list of our defined
Enzyme/PTMs. Please refer to the PEAKS Studio 3.0 Interface section for
information on what these values mean.

Environment Preferences 5[

rEmii'mmmrﬁ- rEXftiliJr |/ Auto De Novo |/ Manual De Novo :r:'?ﬂé[gg':.ﬁbeufra |

Farent mass errar tolerance: ‘0.1 ‘ i |
Fragment mass errar tolerance: ‘0.1 ‘ - |
Enzytme and PTh: |anpsin with Cam - |
Feport top: ‘5 ‘ hd |
Instrument; ‘ Guadrupole-TOF "|
For hest results, try error tolerance of 0.1 for data from Quadrupole-TOF

[¥| Preprocess hefore De Movo

[] Use this configuration as default

| 0Ok H Cancel |

These values can also be set from the Auto de 7ov0 options dialogue that appears before
each Auto de nove operation. Un-checking the box will make the Auto de nove options
dialogue appear before each auto de nove once again.

Protein Identification
Settings for the database search portion of the analysis can only be set immediately
before each protein identification operation. That is to say, to set parameters for

database search and protein identification, we click on the [ Protein Identification
button.

Manual de novo

We may wish to sequence a peptide manually, using spectrum data. PEAKS Studio 3.0
provides us with a set of tools to help us do so. We may need to tweak these tools to
adjust for error tolerance, and to customize the working environment.
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To adjust Manual de novo options, open the Environment Preferences dialogue and
ensure that the ‘Manual de 7000’ tab is selected.

x4
rﬁmnmmmm ﬁ(fﬁﬁ]r rnuhlﬁe}lwﬂ»r Manual De Novo r:'?ﬂér_gg:.ﬁ_'ﬁﬁefra |

|'Tag search parameter:

Maximum tag length | 3 ™ Maximum return |5

[Default random machine error:

Default machine error: |0.5

When sequencing a peptide using the manual de novo tools, we can get PEAKS to help
us by searching to the left or right of a selected peak and returning a set of possible
sequence tags (see Manual De novo section later in this chapter). We can choose how
many search results we’d like to see, and we can choose how long (number of amino
acid residues) we’d like these tags to be at a maximum. To choose how long tags will
be, we click on the “Maximum tag length” dropdown list box, and making a selection.
Choose the number of search results displayed by clicking on the “Maximum return”
dropdown list and making a selection.

Changing the default machine error sets the amount of error PEAKS will tolerate
when tagging a residue. For example: we have a mass difference of 113.14 between two y-ions that
we have labeled. We are fairly confident that this should be tagged L. (Lencine, with actual mass of
113.08), but PEAKS is not labeling it for us. This may be becanse 113.14 s too far out of PEAKS
ervor tolerance for the mass of L. We can tweak the settings until we get the desired result.
To do so, type a value for error (larger numbers indicate greater tolerance) into the
“Default machine error” textbox.

After having made all desired changes, click the “Ok’ button to save changes and exit
the dialogue box. Click the “Cancel” button to exit, discarding changes.




Merge Spectra

We may wish to merge spectra, representing the same peptide, together. PEAKS
Studio 3.0 provides us with a tool to do so. We are usually prompted to merge spectra
when a file is opened, but we may set defaults.

To change default settings for merging MS/MS scans of the same peptide, open the
Environment Preferences dialogue and ensure that the ‘Merge Spectra’ tab is selected.

x|
Retention time range: |SD | ot |
Merge where precursar miz within; |D.D1 | hd |

[[] Use this canfiguration as default

Here we can set which ranges of retention time and mass should be used as criteria
for merging spectra together. After having made all desired changes, click the
“Ok” button to save changes and exit the dialogue box. Click the “Cancel” button
to exit, discarding changes.
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PEAKS Studio Usage

A task based guicte fo processing onr data with PEAKS Studio 3.0.

his chapter deals with usage. It is broken up into tasks that a typical user

might perform. It assumes we can identify parts of the Graphical User

Interface and that we are familiar with how PEAKS Studio 3.0 can be

configured. The preceding two chapters provide in depth help on these
subjects, and should be used as a reference. Such detail has occasionally been omitted
from this chapter in the interest of succinctness.

The three cores of PEAKS technology are the manual de novo sequencing, automatic
de novo sequencing and protein identification tools. Help is provided for these tasks,
but also, how they may be used to perform less obvious operations.




PEAKS demo data
can be found in the
DATA sub-
directory, located
in the PEAKS
directory.

Loading data into PEAKS Studio 3.0

PEAKS Studio 3.0 can be used to process data from any MS/MS instrument, provided
the data is accessible, or can be converted to an accessible format. PEAKS handles
data files in the following formats:

= PKL
= DTA
= MGF

* ANZ — the zip compressed XML based file format associated with
PEAKS

* XML format files from Waters/MicroMass’s ProteinLynx software
= RAW files from Waters QTOF instruments
» XML format files using the mzXMIL schema

= DAT files created by BSI’s ABI converter software

Opening data files
In order to do any data processing we must first load our spectrum data into PEAKS

Studio 3.0. To open a data file, click the [=] icon on the toolbar in the upper left corner
of the PEAKS window or select “Open” from the “File” menu.

¥4 PEAKS Studio
| Edit View Tools Windows Help

"= oper e N EE P

Load DOy o |

Load raw data files... i |D e el E o
Load 4700 Data .. -
[} multiple specira
ﬁ Close Z1 phosphonyated
[} single spectra
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SampleData.pkl
& Save As
[ Save Al
Export
@ Exit
File Marre: [ | Open
Files of Type: |_ann .anz.dta .mof .maxml .pkl xml b (Spectrum Data File) '| | Cancel |




If we don’t want to
merge peaks, we
can enter 0.00, or
press the Cancel
button.

Select a file (in .ANZ, .pkl, .mgf, .dta, or .txt format). Click the Open button.

Usually, PEAKS Studio 3.0 will then ask us if we want to reduce the amount of data to
process, and at the same time, improve the data quality, by merging together MS/MS
scans of the same peptide. To do so, choose a mass range, and press the OK button.
MS/MS spectra whose patent ions ate within this mass range of each-other will be
merged together. If the data file also contains retention time information, we can merge spectra whose
parent ions’ mass and retention time are closer together than the specified mass range and retention time
range.

Merge Spectrum ) il
Merge Spectrum ) ﬂ Retention time range: |SD | 3 F |

Mass range tolerance: ‘U-m | et | Mass range tolerance: |D.IZI1 | - |
[C] Use this configuration as default [_] Use this configuration as default
| OK | | Cancel ‘ ‘ 0K | ‘ Cancel ‘

The data file we just opened appears in the Peptide Data Frame on the left. It is
represented by its file name. Each spectrum contained in the data file is represented by
its precursor ion information (m/z value followed by the chatge of the precursor ion
that generated the spectrum).
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Loading a directory full of data files

DTA spectrum data files can be opened by the same procedure as listed above.
However, as we know, some DTA files contain the data for only one spectrum. As
such, we may find it useful to import a whole directory (containing DTA MS/MS
spectrum data files for a whole MS scan) at once, and consider it as one MS scan.
PEAKS Studio 3.0 provides a tool for doing so.

Under the “File” menu, click “Load Directory..”. Now browse to the directory we
wish to load.

Do not select a file within the directory; rather select
File | Edit Tools Windows Help the directory itself. Press the Open button.
1 Open Ctrl-0 5} |g_:||E|
R — As above, the Merge Spectra dialogue will appear.
LDS’ AL Press OK to merge, or Cancel to skip this step.
@ son
B s T After loading the spectra, we can choose sort the
Export » spectrum by the source filename or by the precursor
@ Exit m/z value of spectrum. To do so, right click the
parent node on the Peptide Data, and choose to sort.
Importing RAW data

PEAKS Studio 3.0 can import RAW data from our Waters/MicroMass QTOF
instrument. To do so, we choose “Import RAW data” from the File menu. As above,
the file browser appears. Choose the .RAW data, and click the Open button. Again, we
have the option to merge spectra, or not.

Importing Data from the ABI 4700

BSI has created a tool, separate from PEAKS Studio 3.0,Converter to extract the data
from an ABI 4700’s Oracle database. To start up the ABI 4700 Data Extractor, open it
from the Start menu, for Windows, the default location will be "Programs = Peaks
Studio = ABI Converter".

System Requirements

This extractor can be installed on the same machine as ABI 4700 Explorer and the
Oracle database (we will call this machine the 4700 SERVER in the following
instructions) or another machine that has direct network access (no firewall, no proxy
required) to the 4700 SERVER. Windows 2000 or Windows XP is recommended for
use with this tool.




Configuration:

Before using the ABI 4700 Data Extractor, we should configure it. To do so, we can
choose “Settings” from the “File” menu. The configuration needs the following
information:

" 4700 SERVER Name or IP Address: input “localhost” if the Extractor is
running on the 4700 SERVER (this is the default value), otherwist enter the IP
address of the 4700 SERVER.

" The socket used by the 4700 SERVER: this is the port that the Oracle
database listens to (the default is 1521).

" Username to access the Oracle database: most likely we do not need to

change this (the default is “tsquared”).

* Password to access the Oracle database: mostly likely we do not need to
change this one either.

Steps to do the data extraction:
1. Load Spot Set List from the database (Do it via menu File | Load
Spot Set List) The extractor will export the peak list of a spot set into a
PKL file.

2. Open a Spot Set (menu File | Open Spot Set) Spot Set Chooser will
help the user to choose a spot set. After selecting a spot set, click 'OK'
to open it. The job run information of a spot set will be shown.

3. Select a job run There is a radio button before each Job Run, only the
MS/MS job tun can be selected for export, because we need the
precursor information. Select a Job Run and click 'Convert' to do the
extraction.

4. Choose a filename to save After clicking the 'Convert' button, the user
needs to input a file name. And the peak lists of the selected job run
will be exported.

Using Peaks Studio with modifications (PTM)

PEAKS Studio 3.0 provides the most flexible handing of post-translational
modifications of any software built for de novo sequencing and protein ID. Users are
free to create their own modifications (see the Creating a New PTM scction), and
search for any combination and any number of modifications.

In order to search for modifications, we must tell Peaks which ones to look for. To do
so, we must create and use “Enzyme/ PTMs set”. For more help creating




The more variable
PTM we turn on,
the more
ambiguous will be
the results.

Enzyme/PTMs sets please refer to the Peaks Properties Configuration part of this
chapter — look for the Enzyme/PTMs Set editor heading, and more specifically, the
Creating a new Enzyme/PTMs set scction.

Auto De Movo B il

Farent mass errortolerance: |IZI.IZI1 | - ‘
Fragment mass errar tolerance: |IZI.1 | o ‘
Enzyme and PTH: Tripsin with Carm - |
Report top: Trypsianhnsphnnrlatiun

idong
Instrument: ]

ITrypsin with Carn

DR
Trypsin without PThis [}5 )
[] Use this configuration as et Unknown Erizyrrie without PTMs

For best results, try error tolerand

Edit PEAKS Properties OK Cancel

Open the PEAKS Properties dialogue, by clicking the ‘Edit PEAKS Properties’ button
from the Auto de novo properties dialogue, or the Protein Id properties dialogue.
Ensure that the “Enzyme/PTMs set” tab is selected and click the ‘New” button.

In the first screen that appears (under the ‘Name’ tab), we should choose a name that
refers to the enzyme we used to digest and reminds us of the PTM Peaks must look
for. In the ‘Enzyme’ tab, we must select the enzyme that we used to digest our sample
from the drop-down list. Finally, in the ‘Modifications’ tab, we must select which
PTMs Peaks should look for. Select PTMs as Varied or Fixed by clicking on a PTM in
the list on the left, and pressing the ‘Select as Fixed” button or ‘Select as Varied” button.
Press the ‘OK button to save this set and it will appear in the list of Enzyme/PTMs
sets. For our convenience, this set will be saved within Peaks since we will probably
process many samples this same way.

Now that we have created the Enzyme/PTMs set we can select it before running auto
de novo ot protein ID.

Remember, when doing protein identification, we will get best results if we:
® For the Protein Identification database search portion, choose an Enzyme and
PTM set that contains the correct enzyme and correct PTMs. If we don’t

know which PTM to expect, turn them all on.

= For auto de novo, choose an Enzyme and PTM set that contains the correct
enzyme, correct fixed PTM, but no variable PTM.

Remember, when doing auto de novo sequencing, we will get best results if we:
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Suggested values
for error tolerance
appear on-screen.
In most cases, we
can use this
number for both
parent and
fragment error.

We should begin
by using the
suggested error
values, then try
some slightly
higher or lower
ones to find the
best result.

* Choose an Enzyme and PTM set that contains the correct enzyme, correct

fixed PTM and a few variable PTM.

Auto De novo Sequencing

To begin auto de novo sequence derivation, we:

1. In the Peptide Data Frame, select the data file(s) containing the spectra that we
wish to sequence by Auto de nove. We can also select an individual spectrum,
or a few spectra within a data file; auto de novo will proceed on only the spectra

selected.

2. Click the |@ Automatic De novo toolbar icon

Or

Select “Auto De novd” from the ‘““Tools” menu.

Or

Right click on the selected spectra or data files and select “Auto De novo” from

the popup menu

The Auto de novo Parameters dialogue window will appear:

Auto De Novo

Parent mass error tolerance:
Fragment mass error tolerance:
Enzime and PTh:

Report top:

Instrument;

01| v
0.1 -
|Trg.rpsin with Cam o>
g -
Cuadrupole-TOF o

Faor best results, try error tolerance of 0.1 for data from GQuadrupale-TOF

[ Preprocess hefore De Movo

[_] Use this configuration as default

Edit PEAKS Properties

0K

Cancel

3. If we wish to change any of these parameters, we do so now.




= Parent error tolerance: how much random and systematic
experimental error on the patent/precursor ion mass PEAKS will
account for in its analysis.

* Fragment error tolerance: how much random and systematic
experimental error on the parent/precursor ion mass PEAKS will
account for in its analysis.

* Enzyme and PTM: enzyme that we used to digest our protein sample,
and PTM that have acted on it. See the above section, Using PEAKS
Studio with Modifications PTM, for help.

®  Report top: how many peptide sequences PEAKS will report.
= Instrument: the type of spectrometer that produced our data.

® Preprocess before de novo: whether or not to preprocess (eliminate
noise, identify charge states, and centroid) the MS/MS spectra before
de novo.

Notes on pre-processing

BSI highly recommends using PEAKS to preprocess all data, as opposed
to using instrument vendor software, if the data is to be used by PEAKS.
PEAKS preprocessor should not be used on data that has already been
pre-processed as this will have adverse effects on the results (unless it is
ion-trap data).

4. Press the “Ok” button to commence Auto de novo sequencing.

Once a job is submitted to PEAKS Studio 3.0, it is added to the Task Queue
for processing. After processing, the job is removed from the task queue list,

and the ®icon beside the spectrum (in the Peptide Data Frame) changes to
light green ® and/or an asterisk (¥) appears.




Confidence scores
are probability
based, on a scale
of 0 to 100%

Viewing Auto de novo Results

After performing auto de novo on a spectrum, we may wish to see what the algorithm
determined the peptide sequence to be, and review the results for ourselves. To do so,
we click on the spectrum of interest in the Peptide Data Frame. This brings up the
Main Processing Window for that spectrum.

The most likely peptide sequence candidate, as determined by auto de novo, will be
automatically selected. This is found in the Peptide Candidates Frame, as the top listed
candidate under PEAKS Auto De novo’. In the example above, this is the highlighted
sequence VDVEK. Any modifications that have been found will be shown
abbreviated and in sequence before the amino acid residue they are associated with. If
the PTM was defined/ created by another PEAKS user on another system, the PTM will still be
shown and it can be imported into the local PEAKS configuration as desired.

Right next to the proposed sequence, the auto e novo confidence score is shown.
Positional confidences (that is, confidence that the correct residue in each position has
been identified) are readily available by color coding. Red represents a very high
confidence (greater than 90%), purple represents a high confidence (80 to 90%) blue
represents a medium confidence (60 to 80%) and black represents a low confidence
(less than 60%s). For more detailed positional confidence, we can place our mouse over
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the sequence of interest. A Position Confidence Table will appear, showing the
confidence that each tag/subsequence is correct.

In the Ion Table frame, select a cell from the Ion Table — each cell represents an ion.
This will highlight its position on an error plot (scroll the Ion Table frame down if the
error plot is not visible). A point close to the centerline indicates a more confident




Zoom in far
enough and we
may resolve the
isotopic ladder
(depending on our
instrument/data).

result. We can also notice that the peak corresponding to the Ion we selected is
highlighted on the Spectrum View. Select a whole column to highlight all the points for
that type of ion. The types of ions displayed in the ion table can be configured, choose
Configuration = Edit Ion Table from the Edit menu. FTMS users might find this
particularly useful when sequencing data acquired using ECD.

By looking at the Spectrum View Frame, we can see the strength of the MS/MS peaks
that PEAKS Studio 3.0 has set as ions. The view also displays the mass of the ions at
that peak and the type of ion. Click on a peak to mark it and display its information at
the top left corner of the Spectrum View Frame.

Zoom in by clicking and dragging horizontally on an area of the Spectrum view. The
area over which we dragged will now take up the whole spectrum view. To un-zoom,
press the %] undo zoom icon; or press the [11:1 icon to return to the full spectrum
view.

We may also zoom in on the spectrum using the Spectrum Alignment Frame. Again,
click and drag horizontally on an area of the Spectrum view. The area over which we
dragged will now take up the whole spectrum view. The blue bar beneath the
Spectrum Alignment view shows where we are zoomed in. The white portion of the
bar represents the area that we are zoomed in on.

We can toggle whether or not we’d like to see the positions of the y-ions and b-ions
(and the proposed residues in sequence between them) on the alighment view by
pressing the y-ion ahgnment ® 20d b-ion ahgnrnent ™ icons in the main processing

window toolbat.

To view another peptide candidate, as determined by auto e novo, click on another
peptide in the Peptide Candidates Frame and under ‘PEAKS Auto De novo’. The
information in the Ion Table will change, as will the tags on the spectrum, to reflect the
selected peptide candidate’s sequence.

Preparing to Edit sequencing results

We cannot change the results provided by PEAKS auto do novo or PEAKS database
search. However, we can make a copy of any sequence and edit it using manual e novo
techniques. To copy a sequence for editing:

1. Select a peptide sequence candidate from within the Peptide Candidates
Frame. We can only select one peptide sequence candidate at a time.

2. Right click the mouse button while holding the mouse over that sequence.
A popup menu will appear.
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3. We can select the popup menu item “Copy for manual de novs”. In this
case, the sequence will be automatically placed under the ‘Manual De novs’
heading. A ‘Manual De novs’ heading will be created if there wasn’t one
there already.

4. Now we select our newly copied sequence, under the ‘Manual De novo’
heading, to display this sequence in the Ion Table Frame, Spectrum View
Frame, and Spectrum Alignment Frame.

Now we are ready to edit the sequence, using manual de 7ov0 techniques.




Manual De Novo Sequencing

We can use manual de novo sequencing to fine tune the results of an auto de novo
analysis, or to perform our own sequencing analysis from scratch. PEAKS Studio 3.0
provides a set of tools to help us sequence a peptide, using graphic cues from the
spectrum.

Creating a fresh spectrum for sequencing

We cannot change the results provided by PEAKS auto do novo or PEAKS database
search. Thus, to begin manual e novo sequencing, we must either copy a sequenced
peptide (see above section: Preparing to edit sequence results) or create a new peptide
candidate for sequencing.

To create a new peptide candidate for sequencing:

1. Right click on the ‘Peptide Candidates’ heading, the ‘Manual De novo’, or
any ‘user defined type” heading. This will bring up a popup menu.

2. Select “New candidate for manual e #ov0” from the popup menu

A new candidate will be created under the ‘Manual De novo’ heading, or under the ‘user
defined type’ heading if we selected a user defined type. The new candidate will not
have been sequenced, so it will be represented by the mass difference across the
spectrum (e.g. [945.15] ).

Manual De novo Operations

All operations occur in the Spectrum View Frame of the Main Processing Window.

When the mouse is placed in the Spectrum View Frame, a blue (by default) bar follows
the movement of the mouse. This is the Position Bar and it is used as a cutsor for all
manual de novo operations. The cursot’s position on the m/z scale is enumerated on the
top of the Position Bar.

Selecting a peak
To select a peak, click on it. An orange (by default) bar, called Freeze Bar, indicates the
selected peak.

Alternatively an ion peak can be selected by clicking on its corresponding cell in the
Ion Table.

Measuring distance along the m/z scale

Once a peak is selected with the Freeze Bar, moving the mouse left or right will display
the Position Bar along with a value that represents the m/z difference (as an absolute
value) between the selected peak (orange) and the Position Bar (blue). In the example
below, the distance between the selected peak and the position bar is 51.02 Daltons.
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Measure the m/z difference between two PEAKS

Select a peak (orange line by default) with the Freeze Bar, and move the mouse to the
left or right. Hold the Position Bar above another peak. The number above the Position
Baris the difference between the two PEAKS

Deselect a peak
Double click anywhere in the Spectrum View Frame

Zoom in on part of the spectrum
In the Spectrum View Frame, or the Spectrum Alignment Frame, click and drag the
mouse horizontally. The selected area will be shown in the Spectrum View Frame.

Add (remove) ions to (from) a peak

Select a peak, then right click the mouse anywhere in the Spectrum View Frame. Select
“Set Y Ion” from the popup menu to designate the peak as a y ion, “Set B Ion” from
the popup menu to designate the peak as a b ion, Select “lon Edit” from the popup
menu to view the Ion Editor dialog box and designate the peak as another ion.
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See PEAKS
Environment
Preference
Configuration to
find out how to
change the
sensitivity of the
residue estimate.

Two short cut keys
can be used: 'F6'
for searching the
left side and ‘F7*
for searching the
right side.

The Ion Editor dialogue allows us to add ot remove ion designations to/from a peak.
Select an ion from the ion choice list and press the “Add” button to add it to the
selected ion list. Remove an ion from the selected ion list by selecting it and pressing
the “Remove” button. We can type any comments we wish to make about the
ion/peak, then press the “Apply” button to apply the changes to the selected peak.

Two short-cut keys may also be used to label a peak. Select a peak, then hit the 'y' key
to add a y-ion and or the 'b' to add a b-ion to the peak.

After setting an ion, both the alighment view and the peptide sequence candidate name
(as displayed in the peptide candidate frame) will change to reflect the mass remaining
to be sequenced on either side of the ion. After setting two ions, PEAKS Studio 3.0
will estimate the residue found between them (if a residue corresponds closely to the
mass difference). The peptide sequence candidate name (as displayed in the peptide
candidate frame) will change to show the residue and the mass remaining to be
sequenced on either side of the residue.

Using sequence tags

Searching the C/N terminal by Y/B: right click anywhere in the Spectrum View
Frame to trigger the popup menu. From the menu, select the terminal search of
interest. PEAKS will select the appropriate terminal tags and show them in the Ion
Table Frame. We may test the suitability of a tag by clicking on its radio button; the tag
will be shown, in position, on the Spectrum View. We may insert one or more tags by
clicking on their checkboxes, then clicking the “Apply” button. Press the “Cancel”
button at any time to exit the search discarding changes.

Search a sequence tag: select a peak with a defined ion (i.e. an ion that has been
labeled with a peptide). Right click to trigger the popup menu, then select “Search
Right” or “Search Left” to search peptide tags either to the right or left of the selected
peak. PEAKS will select the appropriate terminal tags and show them in the Ion Table
Frame. We may test the suitability of a tag, by clicking on its radio button; the tag will
be shown, in position, on the Spectrum View. We may insert one or more tags by
clicking on their checkboxes, then clicking the “Apply” button. Press the “Cancel”
button at any time to exit the search discarding changes.

Undoing an edit

If we have made an error in our sequencing it is possible to undo the change. With the
Peptide candidate still selected in the Peptide Candidates Frame, click the previous
peptide El button, to return to the previous peptide sequence. We can click this button
multiple times to return to successively eatlier stages in our edit.

Redoing an edit
If we have undone one too many changes, we can redo that change by clicking the

next peptide [@] button. We can click this button multiple times to proceed to
successively later stages in our edit.




Entering a sequence to see how well it fits the data

If the data is ambiguous, PEAKS Studio 3.0 may not have displayed a particular
candidate that we wish to evaluate, after auto de novo, or protein ID. We may enter
this sequence and have PEAKS Studio 3.0 find if there is any evidence for it in the
data.

For instance, PEAKS may give the sequence RMYNVHGC (phosphorylationS)K for a
particular spectrum, and we may wish to see if there’s any evidence for the
phosphorylation being on the Tyrosine. As such, we may type in our own version of
the sequence and have PEAKS find ions that might support our hypothesis.

To do so, open the spectra in the Main Processing Window, and right click on
“Peptide Candidates” (in the Peptide Candidates Frame). Then, from the pop-up
menu that appears, choose “New Candidate for Manual De Novo”.
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A new node will appear with the heading “Manual De Novo” and beneath it will be
the mass of the residues yet to be sequenced (in square brackets). Right-click on this
heading. In the pop-up menu that appears, choose “New Candidate with user input
sequence”, and the Sequence Input dialogue box will appear.




Short forms for the
modifications may
also be used.
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We can now enter our proposed sequence. The total mass of the residues,
modifications, and un-sequenced masses should equal the total mass of the peptide
(minus water). We might find the mass calculator tool (Tools menu), useful in this
regard.

Enter sequences in the format:

MPELAYLK

[228.09]ELAYLK

DE[226.168]AYLK

EDLLA (phosphorylationY) LK

DE|226.168]A(phosphorylationY) LK
Then press the OK button. The sequence we just entered will appear under the
“Manual De Novo” heading, and when selected, the ions that PEAKS has found to

match the proposed sequence appear on the spectrum, spectrum alignment view, and
ion table.
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Protein Identification

PEAKS launches an amalgamative approach to protein identification called inChorus.
With inChorus protein identification technology, we can use PEAKS together with
several other protein identification methods. This will deliver more protein coverage
and more confidence in results than any one method on its own.

An integral part of the inChorus search, PEAKS own protein identification method is
unique — an improvement on and the ideal compliment to existing tools. The unique
approach is a combination of sequence tag searching and fragment ion mass matching.

The following two sections deal with usage of PEAKS protein identification on its
own, and usage of inChorus protein identification.

PEAKS protein identification

PEAKS Studio 3.0 uses peptide sequence information to filter the protein or EST
database. So, to get useful protein identification results, we must first perform de novo
sequencing on the spectrum data.

If we already have sequence information for this data, we may use this existing
sequence information (manual or auto de novo sequences) to filter the database. If we do
not have existing sequence information, or if we wish to refine our database search by
providing brand new sequence information, we can ask PEAKS to perform auto de
nove before searching the database. Brand new results will not overwrite any existing
sequence data that we have.

1. In the Peptide Data Frame, we select the data file(s) that we wish PEAKS to
use to identify our protein(s). This can be done by clicking on a data file’s
name in, the peptide data frame.

2. Click the "Protein identification" toolbar icon l@
Or
Select “EAKS Protein ID” from the tools menu.
The Protein Identification Parameters dialogue window will appear

3. If we wish to change any of the protein identification search parameters, we
do so now.

Parent mass error tolerance: how much random and systematic
experimental error on the parent/precursor ion mass PEAKS will account
for in its database search.




Suggested values
for error tolerance
appear on-screen.
In most cases, we
can use this
number for both
parent and
fragment error. We
should begin by
using the
suggested values,
then try some
slightly higher or
lower ones to find
the best result.

* Fragment mass error tolerance: how much random and systematic
experimental error on the daughter/fragmentation ion mass PEAKS
will account for in its database search.

x

“Protein ldentification Options

Search in database |SWissPr01 > |

Parent mass error tolerance: |D.1 | v |

Fragment mass error talerance: |D.1 | hd |

Enzyme and PTH: |Tr5rpsin with Cam bt |
Instrument; | GQuadrupole-TOF b |
Reparttop: 10 Rd

For hest results, try error tolerance of 0.1 far data fram Quadrupole-TOF

) Use existing peptide sequences

® Use existing peptide sequences and the results from fresh auto de novo

Auto De Hovo Options
Parent mass error tolerance: |D.1 | hd |
Fragment mass error tolerance; |D.1 | - |
Enzyrme and PTM: |Tr5fpsin with Carn 2 |
Reporttop: |5 | - |

[_] Preprocess hefare data analysis

| Edit Databases and Enzyme/PTM Sets | ‘ 0K | | Cancel |

* Enzyme and PTM: enzyme that we used to digest our protein sample,
and PTM that have acted on it. Protein or EST databases contain
unmodified peptide sequences, so PEAKS will mathematically remove
the PTM for comparison with the database.

Best practices for setting modifications (PTM)

The developers have discovered that database searching often returns
better results if the auto de novo analysis is run with no variable PTM
(perhaps one or two if necessary), but with the correct enzyme and fixed
PTM. Modifications should be then turned on for the database search
function. m/z tolerance can also be adjusted separately for each phase to
allow us to tweak the results.

= Search results in database: The default database is shown, but can be

changed. See configuration section to find out how to change the
default database.




®  Use existing peptide sequences and the results from fresh Auto de novo:
Select this radio button if we wish to generate brand new sequence
information to use in filtering the database. Best practices dictate that
we perform this auto de novo sequencing with parameters that differ
slightly from the database search parameters.

® Preprocess before data analysis: whether or not to preprocess
(eliminate noise, identify charge states, and centroid) the MS/MS
spectra before de novo.

Notes on pre-processing

BSI highly recommends using PEAKS to preprocess all data, as opposed
to using instrument vendor software, if the data is to be used by PEAKS.
PEAKS preprocessor should not be used on data that has already been
de-convolved by instrument software as this will have adverse effects on
the results (unless it is ion-trap data).

PEAKS preserves the original data, and does not save the results of its
preprocessing. As such, the decision to preprocess or not should be
independent of what we’ve already done with PEAKS.

4. Press the “Ok” button to commence Auto de novo (if we have so chosen)
and subsequent protein identification.

If we have chosen to perform auto de novo prior to our database search, the Auto De
nove process will appear first in the task queue. Once this is finished the database search
will begin. If PEAKS finds protein candidates after searching the database, a Protein
Identification results window will appear:

inChorus protein identification

inChorus protein identification will call upon several search engines for protein
identification. Once we load our data into PEAKS, we can invoke (start searches
running on) several search engines at once. When all the results are returned, PEAKS
Studio 3.0 will compare the answers and summarize everything in one simple report.

1. In the Peptide Data Frame, we select the data file(s) that we wish PEAKS to
use to identify our protein(s). This can be done by clicking on a data file’s
name in, the peptide data frame.

=

2. Click the "Protein identification" toolbar icon "f"‘— .

Or
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Help is sometimes
available by
holding your
mouse over, or
clicking on a part
of the screen.

The section below,
entitled viewing
PEAKS protein
identification
results, describes
the ‘PEAKS only’
report.

Select “inChorus Protein ID” from the tools menu

The inChorus database search launch window will appear:

=

[ ¥Tandem Search Options

(] Omssa Search (W) Options

[¥| Peaks database Search = Options
OK Cancel

Now we can select each of the protein identification tools we would like to use by
putting a checkmark in the corresponding boxes. Search parameters for each program
can be set by clicking the corresponding Options icon.

Options screens each of the programs available to inChorus are designed to work in
the same way as options screens for the original programs. For help in setting search
parameters for each program, please refer to that program’s user manual. In the case of
PEAKS database search, please refer to the above section.

Viewing Protein identification results

To view Protein identification results for a data file, we must have performed PEAKS
protein identification or inChorus protein identification on that data file. The inChorus
dynamic result report is more comprehensive than the original PEAKS protein
identification result report.

Viewing inChorus protein identification results

If we have run inChorus protein identification, both the PEAKS protein identification
result report (showing PEAKS only results) and the inChorus dynamic result report
will be available. Selecting a data file’s “Protein ID Result” (from just beneath the data
file’s name in the Peptide data frame) will present us with the PEAKS only results. The
inChorus dynamic result reports are represented by the time stamp and database
searched (just under a data file’s “Protein ID Result”). Click on one to display it.

The inChorus dynamic result report allows us to view results by peptide or by protein
and to check on the search parameters we used to generate these results.

Search parameters that we used when generating this report are preserved for future
reference, and are available by clicking on the search parameters tab.

Peptide view is available by clicking on the peptide view tab. In tabular format, it
displays relevant information about each peptide found. Since two peptides may match
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Scores associated
with each peptide
represent the
quality of the
match and the
number of
programs in
agreement on the
peptide.

to one MS/MS spectrum, they are visually grouped together (using colour) by MS/MS

scan.

I SampleData.anz

[ Peptide View_|{ Pratein? arch parameters
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When we first load the report, it is sorted by MS/MS index. This is meant to represent
scan number, or file name if working with DTA files. In the example above, there were
two matches returned for MS/MS scan #1, EDLLAYLK and AEKNFDLK. For scan
#2, there were three possible peptides matching, for number 3 there were two, and so
on. Fach peptide is given a score, and the protein it matches is displayed for reference,
under “Accession No.” Each search program that agreed on the peptide is given a
checkmark under its column.

This list is sort-able. Click on a column header to sort the list using that columns
values. For example, sort by score. Clicking again on the same column header will
toggle ascending/descending sort. When sorting, the grouping by MS/MS scan
number will be retained except when sorting by Accession No.

Clicking on this report will highlight the spectrum in the Peptide Data tree on the left.
Select multiple spectra by clicking and dragging, using shift+click or ctrl+click. In this
way, the highest scoring peptides may be selected and isolated for further analysis.

Protein view is accessed by clicking on the Protein View tab. It collects all the peptide
identifications together, summarizes which proteins were present in the sample, and
groups homologous proteins together. The same information is displayed in the
peptide view as in this protein view, however the results are organized to best enable us
to evaluate at the protein level.
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esult from database SwissProt(0.1 0.1 Trypsin with Cam)
Accession Mass Score Coverage Description

CYC_BOWVIN  more 11554.328 72.58% 54.81%  (P00006) Cytochrome c.
CTHZ_WOUSE more 1052799 40.75% 4.62% (Qa1301) Alpha-2 catenin (Alpha-catenin related protemn) (A
GRT1_SCHFPO 7440078 13.06% 2.31% (QPC469 Zinc finger protein gril

CYC_BOVIN tnore.. (PO0006) Cytochrome c.
Mass: 11572339 Score:72.58% Coverage:54.81% [Show mmussed de novo results]

Mz Charge Mricalc) Start End Score Peptide
4827 1 96ISITES 02 99 51.16% EDLIAVLK
sg48 2 1167.6147 28 3% 63.01% TGPNLHGLFGR
5803 1 5883505 4 8 46.62% FKGKK

6344 1 63333495 0 13 50.80% IFVQK

6783 1 BTTAT48 74 79 S0.80% YIPGTK

This section of the report behaves in exactly the same way as the original PEAKS

protein identification results report. A full description is in the next section.

Viewing PEAKS protein identification results

Selecting a data file’s “Protein ID Result” (from just beneath the data file’s name in the
Peptide data frame) will present us with the proteins found for that data file in the

Protein Identification result window.

After selecting the results to view, the protein candidates Peaks has identified will be
shown in the index section at the top of the report. Very similar proteins are grouped
together. To see the full list of proteins within each grouping, click the more hyperlink.

Another window will appear, showing all the related proteins:

% SwissProt{0.1 0.1 Trypsin with Cam)

Result from database SwissProt(0.1 0.1 Trypsin with Cam)
Accession Mass Score Coverage Description

CYC_BOWVIM 11547.01  90.32% 50% (P0000E) Cytochrome c.
CYC_EQUAS 11662.1090 90 32%% 50% (P00005) Cytochrome c.
CYC_WINEC 11418.004  98.04% 42.31%  (PO0013) Cytochrome c.
CYC_MIELE 11460988 98.04% 42.31%  (P00012) Cytochrome c.
CYC_CANFA 11476.009 98.04% 42.31%  (P0O0011) Cytochrome c.
CYC_HOREE 11676.125  95.78% 35.58%  (PO0004) Cytochrome c.
CYCZ WOUSE 11556983 9507w 31.73%  (PO00LS) Cytochrome c, testis-specific.
CYC_SCHGR 11736.134  94.93% 20.91%  (PO0040) Cytochrome c.
CYCZ_RAT 11585.262  01.46% 268.92%  (P10715) Cytochrome c, testis-specific.
CYC LAMTR 11515.0625 91.46% 26.92%  (PO0028) Cytochrome c.

1]

73



This window is equivalent to, and behaves the same way as, the Search Result Report
Frame (of the Protein Identification Result Window) but lists only those proteins
identified within that group. The following paragraphs describe the use of both.

Clicking on the Accession number hyperlink (in the index at the top) will scroll down
to section of the peptide match report that corresponds with that Accession number.
In this section of the report, the spectra that PEAKS found to match that protein are
displayed, each with a score, and ordered by mass. It is possible that not all spectra
from a data file are shown. Only the ones that matched the protein show up. More
spectra matching with higher confidence scores indicate better probability of
having identified the correct protein.

CYC_BOVIN (PO000G) Cytochrome c.
Mass:11547.01 Score:99.22% Coverage:50% [Show mizzed de novo results]

Mz Charge Mr(calc) Start End Score Peptide
4827 2 9455171 92 99  99% EDLIAYLK

5848 2 11496042 28 3% 00% TGPNLHGLFGR
6344 1 6153744 9 13 93.58% IFVQK

6783 1 659.36426 74 70 84.58% YIPGTK

7188 2 14376525 40 53 99% TGQAPGFSYTDANK
7794 1 760.43054 80 86 86.4% MIFAGIK

7929 2 15657474 39 53 97.83% ETGOAPGFIYTDANK
[Feturn to top]

While viewing this section of the report, click on a Peptide sequence hyperlink to bring
up the Main Processing window associated with that spectrum and peptide sequence.
Or, click on the more hyperlink to again bring up the list of related proteins (see
above). Or, click on the protein’s accession number to access the protein view:
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F% Protein Yiew x|

View with web browser

Filename: DAirogersibly DocumentsiPEAKSDatalsample multiple spectralCytochrome-C.pkl
CYC_BOVIN Mass: 11547.01 Score; 99.22%

(PO0ODDG) Cytochrome c.

Seguence Caverage: 50%

MNCEI BLAST search of CYC BOVIN
Links to retrieve entries containing this sequence from MBI Entrez:
Accession]D Description
CYC BOVIM (POO00A) Cytochrame c.
Matched peptides shown in Red

1 GDVEEGEKIF VORCAQCHTV EKGGEHETGP NLHGLFGRET GOAPGESITD
51 ANENKGITWG EETLMEYLEN PEEIIPGTEM IFAGIKEKGE REDLIAYLEK
101 ATNE

Peptides List

Mz Charge Mr(calc) Start End Score Peptide
4827 2 94552 82 498 9% EDLIAYLE

5848 2 11486 28 38 9% TGPMLHGLFGR
634.4 1 B15.37 9 13 92.53% IFVQK

6783 1 BS9.36 T4 TR B443% YIPGTK

T80 2 143765 40 43 9% TGOARGFSYTDAMNK
TTH 4 1 TRNA43 80 BA AR 4% MIFAGIL -

This protein view window shows the peptide matches for this protein in red. Clicking
on the accession number in this window links to the NCBI Blast page and inputs
search parameters for the protein. If we click the “View with web browser” button at
the top of this window, PEAKS loads this same report into our default web browser in
html format for print or incorporation into reports.

We may have performed database searching twice using the same data file. If this is the
case, two sets of protein candidates will be available. They are both listed in the
Database frame and can be identified by the name of the database we searched and the
parameters we used when searching the database. In the example below, we searched
through two separate databases. Clicking on either one brings up its results. If we've
only searched once, there will only be one database to choose from and its results will
be automatically displayed.

I Cytochrome-C.pkl
Frotein Candidat

SwissProt(0. 1§ [ cytochrome-C.pkl :
R

Frotein Candidates
SyissProt(0.1 0.1 Trypsin with Cam)
| umani0.1 0.1 Trypsinwith Cam)

esult from
Accession
PI00353043 esult from database SwissProt(0.1 0.1 Trypsin with Cam)

IPI00215916 Accession Mass  Score Coverage Description
[PI00103752 CYC_BOVIM  more 11547.01 90.22% 50% (PO000GY Cytochrome c.
[PI00028280 SRD1_YEAST more 25853277 32.80% 8.44% (PO2007) Pre-rRNA processing protein SRD1

Phe i gl allCYC _BOVIN more . (PO000E) Cytochrome o
Mass: 11547 01 Score:?9.22% Coverage: 50% [Show missed de novo results
Sy ;. SHYErSIR: 0% B o S 1

- - e

e

"
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A note on differentiating between results

PEAKS Studio 3.0 differentiates between protein identification runs by
the database search parameters that were used, not the auto de novo
parameters. As such, if we do not change database search parameters
before searching, we will overwrite whatever previous search results we
had — no matter how much we alter the auto de novo parameters. If this
presents a problem, please contact technical support.

Please see the walkthrough in chapter 3 for an example of viewing protein
identification results.
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Manipulating Data Files

Editing Precursor information
It is possible that the precursor information, as listed

in the Peptide Data Frame, is incorrect. If the charge  File Edit Tools Windows Help
listed is wrong, or if the m/z listed is even slightly [a|dE[®| B[&] & (2] E]F

incorrect (more than 0.1 Daltons, depending on the | = Peptide Data
. . = "Apo-myoglobin.ann
accuracy selected) it could really affect the quality of 3 *408.2 2
the tesults. In this case it is imperative that we s
change the precursor information. The change will B 6 7
. 4 gy Edit Precursor !
only affect the ANZ file we are working on. ® 74 Copy -
80 :
. . . ® 51 ;
To edit precursor information, select a spectrum by @ 90{ Peaks Muto De Nowo | -
clicking on its name, then right click the mouse 15T |II :

while holding it in position over the name. A small
menu will appear. Click on “Edit Precursor”.

#ill Precursor Editor . x|
Mass 6785

In the dialogue that follows, type the new [Intensitiy :
precursor information into the appropriate Charge 2
textboxes. Click the “Apply” button when finished
to apply the changes. Click the “Cancel” button to

‘ Apphy || Cancel |

exit, discarding changes.

The precursor information will be updated, reflected by a change in the name of the
spectrum in the Peptide Data Frame. A * will also appear in front of that name,
indicating that there is unsaved information pertaining to that spectrum.

Merging MS/MS scans of the same peptide

If we’ve done several MS/MS scans of the same peptide, we may want to reduce the
amount of data to process, and at the same time, improve the data quality, by merging
all of a peptide’s MS/MS scans together. Often, we choose to metge spectra while
loading a data file.

To merge spectra after opening a data file, choose Merge Spectra from the Tools
menu. The Merge Spectrum dialogue will appear. After pressing the OK button,
MS/MS spectra whose patent ions ate within this mass range of each-other will be
merged together. If the data file also contains retention time information, we can merge spectra whose
parent ions’ mass and retention time are closer together than the specified mass range and retention time
range.




Changes made to
the original
spectrum after
duplication will not
affect the
duplicated
spectrum.

Merge Spectrum il

il Retention time range: |SD | G F |
Mass range tolerance: |U-U1 ‘ ot | Mass range tolerance: |IZI.D1 | - |
[ Use this configuration as default [_] Use this configuration as default

| OK ‘ ‘ Cancel | | OK ‘ | Cancel |

Cutting and Copying Spectrum Data

If we wish to move spectrum data from one data file to another we may do so by
copying and pasting it (see below for pasting instructions). Also, we may wish to make
a copy of the spectrum in the same data file in order to re-sequence an individual
spectrum using different preferences. Cutting spectrum data will remove it completely
until pasted. Copying spectrum data will duplicate the spectra when pasted. To
cut/copy spectrum data:

Select a spectrum by clicking on its name (select multiple spectra by holding
down the ‘control’ key and clicking on any number of spectrum) in the Peptide
Data Frame.

Right click on one of the selected spectra. A small pop-menu will appear.
Select “Cut” or “Copy”

OR

Click the “Copy” button E or “Cut” button & in the main toolbar.

Copied/Cut items will remain on the clipboard until replaced by another copied/cut
item. Warning: unless pasted, a cut item will be lost, as subsequent cut/copied
items will displace it from the clipboard.

Pasting Spectrum Data

After having copied or cut spectrum data, we would like to paste it into another data
file, or the same data file. To paste spectrum data:

1. Select the data file into which we wish to paste the spectrum (or spectra)
by clicking on its name in the Peptide Data Frame. You may only choose to
paste into one data file at a tfine.

2. Right click on one of the selected spectra. A small popup menu will
appeat. Select “Paste” from the popup menu.

OR
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If we know which
proteins to look
for, we can create
our own FASTA
database to
search against.

Click the “Paste” button @ in the main toolbat.

The pasted spectra will appear in the Peptide Data, under the data file into which we
pasted.

Selecting unmatched de novo results

When working with unknown organisms, abundant but uninteresting proteins (like
keratin) can get in the way. We may find it more convenient to eliminate them from
the analysis. To do so, we must first identify which peptides belong to those proteins.
To do so, run PEAKS Studio 3.0’s protein identification tool. The proteins identified
in the sample will be shown in the protein ID report.

In the Protein ID Result report, scroll down to an abundant, but uninteresting protein,
and choose [Show missed de novo results].

CYC_BOVIN more.. (PO000&) Cytochrome c.
Mass:11547.01 Score:99.49% Coverage: 50% [Show missed de novo reﬁts]

&
Mz Charge Mricalc SRl i ] Xl {
L
¢

4827 7 045 517 Please choose the threshold to filter the missed de novo results:

584.8 2 1149.60¢ Ll

634.4 1 815.374 | OK H cancel ‘ -
6783 1 650, 3642 14
Ti8 8 2 1437 6525 40 53 0% TGLAPGFEYTDANK - r/
W S T Py S S

A dialogue box will appear, asking us to choose the threshold to filter the missed de
novo results. Spectra whose de novo sequences include a result with greater than this

percentage confidence (>90% confidence in the example above) will be chosen. Press
OK.

Right click anywhere in this report. From the pop-up menu that appears, click “Select
spectra in data tree”.

FMissed do novo results - ll

Missed auto de novo results
Soore threshold: 90%:

MZ Charge Score Peptide Source
4827 1.0 08.6% EDLLAYLK PEAKS Auta Die Nasa (0.1 0.1 Trypsin with C:
5848 1.0 9% TGPNLHGLFGR (0.1 0.1 Trypsin with C:
634.4 1.0 9% LFVOE (0.1 0.1 Trypsin with Can
678.3 1.0 % YLPGTE (0.1 0.1 Trypsin with C:
7794 10 97.62% NWLFAGLK PEAKE Auto De Movo (0.1 0.1 Trypsin with C;
7929 1.0 08.03% KTCGAGAPGFIYTDAMNK PEAKS Auto DeMovo (0.1 0.1 T
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Running protein identification on select spectra

When searching our dataset against a particular database, Peaks may not have found a
hit for certain spectra. If these are good data, we may wish to try searching them
against a more general database. Before we do so, we must create a new data set with
these “good spectra that did not match”. This is essential so that we can organize our
data well, and because Peaks will only run Protein ID on all the spectra in a data node.
To create a new data node:

1. Make a new Data node by 2. Select the relevant spectra 3. Click the new node and press

right clicking on the peptide data — using <shift>+click and the paste button. Pressing the +
node. The new node appears as — <ctr/>+click, then press the next to Datal will expand it
“Datal”’. copy button. and reveal the pasted spectra

P4 PEAKS Studio P4 PEAKS Studio P4PEAKS Studio

File Edit Tools Windows ¥ File Edit Tools Windows File Edit Tools Windows ¥

os®®] [u]x]al &‘ E=EE

ALl SIoio® [ |

El Peptide Data A .
ki } = *Cytochrome-C.pkl & =l Peptide Data
G 4827 2 - =l *Cytochrome-C.pkl ’
W *584.8 2 3 G #4827 2 .
G 58831 ® +539.31 ( W t584.8 2 *
G 63441 53441 4 *6E9.3 1 ;
W *B7.21 i *678.31 4 *B34.41
71882 4 Wiz W *B7E31 ¢
® 3 b \ @ +7288 2 4
i *79202 gy b © 770,41
i *817.32 stz ® oo
W *1105.4 2 110542 / :
Po-ie e W *1125.02 W *817.32 \
Data W *1105.4 2 3
W *1125.02 {
v *Datal :
e s f)

Now we can run protein identification on Datal. We can save that dataset in a new file,
or any of the other functions that apply to regular nodes. Make sure the new node is
selected before running protein ID (or any other function) on it.




Using the Mass Calculator

FS PEAKS Studio

tool to help us determine the =7 :
molecular weight of a peptide. To File Edrt [ﬁuﬁﬁj hdaws el

access the mass calculator, open @Eﬁﬂl ¥ Enable Tasks Running :_@(E

The mass calculator is a simple

the “Tools” menu and click [ Peptide & Auto De Novo
“Mass Calculator”. The mass = *gES {
calculator will appear . B Protein Identification i

[ Mass Calculator | ~
We can also load the mass WIS T éi\1:\%—
calculator outside of Peaks, and W *1479.7 1
separately. To access the mass *__.*1539-81
calculator without having to load ' - chrome-rnkh . S

PEAKS, click on the mass calculator’s icon in the start menu. It will appear in the same
program group as PEAKS Studio.

When using the |7:Mass Calculator =1o] =l
mass calculator, Edit Help
remember to start
with water. =H20=
hlono Mass: Iﬂwerage Mass18.010565
Clear | Proton || PTM || Num || Back |
| a | | c | | D || E a-hydroxynonenal (HME) z
| F | | G | | H | | I | Appl?ed B?Dsystema nr?g?nal [CATTM) dD =
Applied Biosysterns original [CAT(TM) d8
K L M N Appl?ed B?Dsystema cleavable [CATTM) light
Applied Biosystems cleavahle ICATTM) heawy
p a R 5 AppliedlBinsystemS ITRADTM) multiplexed gquantitation chemistry
Acetylation ||
T v || w || ¥y | Acorvlamide adduct -
We can click any * Amino acids are represented by their single letter symbols. Clicking on an
of these buttons amino acid’s button will add it to the ‘sequence’ above, and add its mass to the
multiple times to mass of the peptide. Note that the peptide’s monoisotopic and average masses
repeatedly add are both computed.
that mass.

* Add a Proton by clicking the “Proton” button. It will be represented by an H
in the ‘sequence’ above.

* To compute the mass of the peptide as if it had been modified, select a PTM
from the list, and press the “PTM” button to apply them to the peptide.




= If the PTM we wish to add does not appear in the list, we may wish to enter
it’s mass manually. To add a mass numerically, click the “Num” button and
enter a numeric value in the dialogue box that appears. Press the “OK” button
on the dialogue and the mass will be added to the sequence.

* To remove a mass that we’ve just added to the peptide, press the “Undo”

button.

Creating a high-throughput workflow

In some situations, we may have many data sets that we wish to process all at once,
and in the same way. PEAKS Studio 3.0 allows us to do this kind of work, and with
minimal effort on our part. By setting up a workflow, we can start a batch process of
several data files, and not worty about it until it is finished.

It is important to note that all the files we load will be processed in exactly the same
way, using exactly the same parameters. If we want to do some differently than others,

we must set up another workflow.

x|

~Step 1: Load Files

Import data: |

|| Browse |

Input file list:

-

-

~Step 2: Merge Spectra

[[] Merge Spectra 3+ Options
~Step 3: Auto De Howvo by PEAKS
[] Auto De Movao & Options
~Step 4: InChorus Database Search
[ ¥Tandem Search Options
[[] Omssa Search (%) Options
[[] Peaks database Search 3 Options
~Step 5: Save Result

‘ OK | ‘ Cancel |

and/or save location.

Stepl: Load files — click the browse button to
open a file chooser. From the chooser, select
several files by shift+click or ctrl+click, and
pressing the “OK” button. Load more files by
pressing browse again, or remove them from the
list by right clicking on them.

Step2: Merge Spectra — choose whether or not
to merge MS/MS scans of the same peptide
(within each data file, not between files).

Step3: Auto de novo — choose whether or not to
do auto de novo sequencing. Note that PEAKS
database search requires some de novo
sequencing results.

Step 4: inChorus protein identification — choose
which protein identification programs to run
against the data.

Step5: Save results — each result will be saved
automatically into an .ANZ file with the same
name as the data file. All files will be placed in
the same folder. Typing in the textboxes, or
clicking each file’s button changes the name




Saving Results

Saving results will preserve our work for later use. Saving files in PEAKS’s .ANZ
format will preserve spectrum data, manual e 7oveo sequence information, automatic de
nove sequence information, protein identification results, and information about any
PTM that were found in sequence.

To save the results of our analysis, we first select the data file we wish to save in the
Peptide Data Frame.

To save, click the ‘ icon in the main window toolbar, select “Save” from the “File”
menu, or right click on the data file and select “save” from the popup menu. This will
save the processed spectra in ANZ format and of the same name as the data file we
opened.

To change the name of the ANZ file, choose “Save as” from the “File” menu, or right
click on the data file and select “Save as” from the popup menu. You may then change
the file name.

To save all currently opened data files, select “Save all” from the “File” menu.

To export data to a PKL file, we select the data file (not an individual spectrum) to
export. Then, from the “File” menu, select “Export”, then “Export PKL File”. The
spectrum data will be saved in PKL format, but all sequencing and protein data will be
lost.

To export peptide sequencing results to a FASTA format file, select the data file (not
an individual spectrum) to export. Then, from the “File” menu, select “Export”, then
“Export Peptide Sequence”. The sequencing data will be saved in FASTA format, but
will not retain any spectrum data.

To export results to an HTML file, select the data file (not an individual spectrum) to
export. Then, from the “File” menu, select “Export”, then “Export HTML File”.
Peaks will then ask us which results we would like to export. We can choose from any
de novo sequencing or protein ID run we have done. Each will be listed with the
parameter set we used.
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Frequently Asked Questions

The PEAKS EAQ online macy contain maore answers. Check
smmbioinformaticssobtions.con/ fags/ peaksphp

1. Whatis .ANZ format?

The ANZ format is zip-compressed, annotated data files in XML format. PEAKS uses
it to save MS/MS information and peptide information. It supports both single
MS/MS spectrum data and multiple spectra data. All PEAKS products accept and save
files in ANZ format.

Saving files in PEAKS’s .ANZ format will preserve spectrum data, manual de novo
sequence information, automatic de novo sequence information, protein identification
results, and information about any PTM that were found in sequence.

Each ANZ contains an ANN index file, and a folder called ‘spectra’ containing ANN
data files (all use the same extension: ‘ANN’). Each ANN data file contains the
MS/MS information and peptide information from one spectrum. An ANN index file
can be used to organize multiple spectra. The ANN index file links to the ANN data
files.

2. What is the required system configuration for PEAKS?

PEAKS can be run on any computer that supports Sun's Java Runtime Environment
(JRE) 1.4. On installation, PEAKS will install a dedicated JRE for its use, so it can co-
exist with another version of Java on our machine. The system should also have:
1024MB RAM, 1GB free space on hard drive.

3. I started an auto de novo process, but nothing happened. What did I do
wrong?

First, check the Tools menu and verify that Enable Tasks Running is checked. If it is
disabled, the “Task Queue’ will be shown in red and no tasks in the queue will be

processed.




It is possible that the process is running but you just don’t notice. PEAKS processes
the auto de novo task in the background so you can continue to work. This process takes
several seconds. You will find the job is still in the queue if you check the Task Queue
Frame. After the process is done, it will disappear from the queue. By selecting the
spectrum in the Peptide Data Frame, you can find the peptide candidates, the
spectrum image and ion alignment in the main process window.

4. Canl edit the data file manually in PEAKS?

You can edit the precursor information (m/z and chatge) by right clicking on the
precursor in the Peptide Data Frame. However, you cannot edit the spectrum data
itself from within PEAKS.

5. What enzymes should I use to digest the protein, in order to use PEAKS
to interpret the MS/MS data?

The most popular enzyme for digesting proteins for MS/MS analysis is Trypsin.
PEAKS comes with an Enzyme/PTMs set, predefined for unmodified tryptic digests,
to handle this common case. Tryptic peptides typically show excellent MS/MS spectra,
and produce good sequences. If you wish to use a different enzyme, or sequence small
peptides in entitety, you can create a new Enzyme/PTMs set and select another
enzyme. Selecting an ‘unknown enzyme’ places no restrictions on the residues
appearing at the C-terminal end. You may set them yourself.

6. CanI edit/modify the result of PEAKS Auto De novo?

You cannot modify the sequences returned by PEAKS Auto De novo search. However,
you can copy the sequence for manual de novo to achieve the same goal. Right-click on
the desired sequence and select Copy for manual de novo. You can now edit the
sequence and ion assignments in the Manual De novo section of the Peptide Candidates
tree.

7. Why can I not find the Freeze bar to indicate the position of the peak in
the ion edit window when I select an ion in the ion table?

The spectrum is zoomed in to far, or not in the right area. Adjust your spectrum view’s
zoom to 1:1.

8. How can I save the sequences resulting from auto de novo?

You can copy the predicted sequences by right clicking on the sequences, and select
copy. This will copy the sequence of letter symbols to the clipboard. You may then
paste them into a word processor or text editor.

You can print images by clicking the right-most ‘Print result image’ button at the top of
the main process window. Or you can save images by clicking the ‘Export results as




image’ button. The printed or saved images look slightly different to those displayed on
the screen.

9. What is the difference between save data file and save all files?

Save data file: If current data file or the sequencing result of the selected data file(s) has
been changed, PEAKS will save the data file and the sequence information in .ANZ
format.

Save all files: If there is more than one data file loaded, using "save all files" will save all
the data files and their sequence information in their respective .ANZ format files.
There is no need to select any files.

10. We saw a green triangle on the m/z axis of the spectrum. What does
that represent?

This green triangle is used to shown the location of the one charged precursor.
11. Why I cannot delete a task from the Task Queue?
There are 2 steps to remove a task from the Task Queue:

Disable the task running by clicking on “Enable task running” from the “Tools” menu
to deselect it.

Right-click the task in the Task Quene. From the popup menu, choose “remove”.

12. Where can I get the log file for PEAKS?

The log file can offer us some information for bug tracking. PEAKS sets the location
of the log and configuration file, users can not change it. Its location is listed in the
Environment Configuration Dialogue, under the Environment tab.




DEFAULT SETTINGS G l

Program Defaults

These are the default settings for a few of PELAKS parameters. NMany ditanlt
Settings can be changed,

Environment
Default Data Input Directory: last used directory

Default Data Output Directory: last used directory

Automatically close previous open spectrum when opening another one: no

Spectrum Colors

Spectrum Peak: Red
Frozen Peak: Orange
Current Peak: Blue
Y_Alignment: Red
B_Alignment: Blue

Y _JIon: Green

Auto De Novo

m/z tolerance: 0.1

Residue and PTM: Trypsin without PTM
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DEFAULT SETTINGS

Report top: 5 candidates
Source: ESI

Instrument: Quadrupole Time of Flight (QTOLF)

Use Auto de novo and database search configuration as default: no

Database Search phase of Protein ID

m/z tolerance: 0.1
Residue and PTM: Trypsin with Cam
Instrument: Quadrupole Time of Flight (QTOLF)

Report top: 10 candidates

Manual de Novo
Maximum tag length: 3

Maximum return: 5

Default machine error: 0.1

File types

Default save file type: ANZ file.




ABOUT BSI G l

About Bioinformatics
Solutions Inc.

BSI provides adanced sofbware tools for analysis of  biologieal date.

Bioinformatics Solutions Inc. develops advanced algorithms based on innovative ideas
and research, providing solutions to fundamental bioinformatics problems. This small,
adaptable group is committed to serving the needs of pharmaceutical, biotechnological
and academic scientists; and to the progression of drug discovery research. The
company, founded in 2000 in Waterloo, Canada, comprises a select group of talented,
award-winning, and intelligent developers, scientists and sales people.

At BSI, groundbreaking research and customer focus go hand in hand on our journey
towards excellent software solutions. We value an intellectual space that fosters
learning and an understanding of current scientific knowledge. With an understanding
of theory, we can focus our talents on providing solutions to difficult, otherwise
unsolved problems that have resulted in research bottlenecks. At BSI, we are not
satisfied with a solution that goes only partway to solving these problems; our solutions
must offer something more than existing software.

The BSI team recognizes that real people will use our software tools. As such, we hold
in principle that it is not enough to develop solely on theory; we must develop with
customer needs in mind. We believe the only solution is one that incorporates quality
and timely results, a satisfying product experience, customer support and two-way
communication. So then, we value market research, development flexibility and
company-wide collaboration, evolving our offerings to match the market/uset’s needs.

Efficient and concentrated research, development, customer focus and market analysis
have produced: PEAKS software for protein and peptide identification from tandem
mass spectrometry data, RAPTOR and PROSPECT Pro software for threading based
3D protein structure prediction, and PatternHunter software for all types of homology
search sequence compatrison.




LICENSE AGREEMENT G l

PEAKS Software License

This is the sasze agreesent presented on nstalation. 1t is provided bere for
reference on.

If you are evaluating a time limited trial version of PEAKS, and you wish to update the
software to the full version, you must purchase PEAKS and obtain a full version
registration key.

1. License. Subject to the terms and conditions of this Agreement, Bioinformatics
Solutions (BSI) grants to you (Licensee) a non-exclusive, perpetual, non-transferable,
personal license to install, execute and use one copy of PEAKS (Software) on one
single CPU at any one time. Licensee may use the Software for it's internal business
purposes only.

2. Ownership. The Software is a proprietary product of BSI and is protected by
copyright laws and international copyright treaties, as well as other intellectual property
laws and treaties. BSI shall at all times own all right, title and interest in and to the
Software, including all intellectual property rights therein. You shall not remove any
copyright notice or other proprietary or restrictive notice or legend contained or
included in the Software and you shall reproduce and copy all such information on all
copies made hereunder, including such copies as may be necessary for archival or
backup purposes.

3. Restrictions. Licensee may not use, reproduce, transmit, modify, adapt or translate
the Software, in whole or in part, to others, except as otherwise permitted by this
Agreement. Licensee may not reverse engineer, decompile, disassemble, or create
derivative works based on the Software. Iicensee may not use the Software in any
manner whatsoever with the result that access to the Software may be obtained
through the Internet including, without limitation, any web page. Licensee may not
rent, lease, license, transfer, assign, sell or otherwise provide access to the Software, in
whole or in part, on a temporary or permanent basis, except as otherwise permitted by
this Agreement. Licensee may not alter, remove or cover proprietary notices in or on
the Licensed Software, or storage media; or use the Licensed Software in any unlawful
manner whatsoever.




LICENSE AGREEMENT

4. Limitation of Warranty. THE LICENSED SOFTWARE IS PROVIDED AS IS
WITHOUT ANY WARRANTIES OR CONDITIONS OF ANY KIND,
INCLUDING BUT NOT LIMITED TO WARRANTIES OR CONDITIONS OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
LICENSEE ASSUMES THE ENTIRE RISK AS TO THE RESULTS AND
PERFORMANCE OF THE LICENSED SOFTWARE.

5. Limitation of Liability. IN NO EVENT WILL LICENSOR OR ITS SUPPLIERS
BE LIABLE TO LICENSEE FOR ANY INDIRECT, INCIDENTAL, SPECIAL,
OR CONSEQUENTIAL DAMAGES WHATSOEVER, EVEN IF THE
LICENSOR OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE OR CLAIM, OR IT IS FORESEEABLE.
LICENSOR'S MAXIMUM AGGREGATE LIABILITY TO LICENSEE SHALL
NOT EXCEED THE AMOUNT PAID BY LICENSEE FOR THE SOFTWARE.
THE LIMITATIONS OF THIS SECTION SHALL APPLY WHETHER OR NOT
THE ALLEGED BREACH OR DEFAULT IS A BREACH OF A
FUNDAMENTAL CONDITION OR TERM.

6. Termination. This Agreement is effective until terminated. This Agreement will
terminate immediately without notice if you fail to comply with any provision of this
Agreement. Upon termination, you must destroy all copies of the Software. Provisions
2,5,0,7 and 10 shall survive any termination of this Agreement.

7. Export Controls. The Software is subject at all times to all applicable export control
laws and regulations in force from time to time. You agree to comply strictly with all
such laws and regulations and acknowledge that you have the responsibility to obtain
all necessary licenses to export, re-export, or import as may be required.

8. Assignment. Customer may assign Customer's rights under this Agreement to
another party if the other party agrees to accept the terms of this Agreement, and
Customer either transfer all copies of the Program and the Documentation, whether in
printed or machine-readable form (including the original), to the other party, or
Customer destroy any copies not transferred. Before such a transfer, Customer must
deliver a hard copy of this Agreement to the recipient.

9. Maintenance and Support. BSI will provide technical support for a period of thirty
(30) days from the date the Software is shipped to Licensee. Further maintenance and
support is available to subsctibers of BSI's Maintenance plan at BSI's then current
rates. Technical support is available by phone, fax and email between the hours of 9
am and 5 pm, Eastern time, excluding statutory holidays.

10. Governing Law. This Agreement shall be governed by and construed in
accordance with the laws in force in the Province of Ontario and the laws of Canada
applicable therein, without giving effect to conflict of law provisions, and without
giving effect to United Nations Convention on contracts for the International Sale of
Goods.
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